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Searching for our origins…

The search for planets around stars other than

the Sun, called “exoplanets”, has been one of the

hot topics in Astronomy in the last decades. As of

today, around 4700 exoplanets have been

confirmed1 in our galaxy, out of which 3500 are

planetary systems, including 790 are multiple-star

systems. If our galaxy contains between 100-400

thousand million stars and 2 thousand million

galaxies have been detected in the observable

Universe,  imagine how many exoplanets

can possibly exist orbiting around those stars!

Figure 1: Artist impression of CHEOPS (Credit:

ESA)

European Space Agency (ESA) missions like CoRoT, CHEOPS or GAIA have been

contributing to this search for exoplanets since 2006, together with NASA missions Kepler

and TESS.

Figure 2: Habitable Zone (Credit: Astrobiology, NASA)

A further contribution comes from the

ESA/NASA space mission Hubble as well as

telescopes on Earth such as GTC and

antennas like ALMA.

In order to understand whether these

exoplanets could be anything like our Earth,

we also have to study the star they are

orbiting.

1 http://exoplanet.eu/catalog/
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Just like the Sun in our case, stars play a crucial role in the evolution of planets and the

possibility of hosting life. If we search for life in terms of liquid water detection on the

planet’s surface, we will arrive at the definition of a planet in the habitable zone, shown in

Figure 2.

Throughout this activity you will enter the fascinating field of how and where stars form.

There are still many mysteries around the formation of stars... If you want to help

scientists at ESA to solve this challenge, we will be one step closer in the search of

our own origins.
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In order to put into context, we recommend to watch these videos:

● This is ESA (10 min)

● ESAC: ESA’s A window on the Universe (3 min)

● Presentation to ESA/ESAC/CESAR (6 min)

● Here there is another complementary set of videos.

We recommend working in teams of (4-6) people, with a clear role in their team, assigned

per profession. You will fill Table 1 for the coming Challenge with a name for their Team

and the name of the team members after having agreed among themselves on their role in

the team.

Challenge
ID

Team number
(1-6):

Names

Profession Mathematician/
Software engineer

Astrophysics Engineer Biologist

Roles
Lead the correctness

of the calculations

Lead the use of the
virtual telescope
ESASky and the
understanding of

their celestial
objects.

In charge of finding
the optimum

strategy agreed
among the team
members and its
correct execution.

Lead the more detailed
research about the

scientific understanding of
the energetic processes
and composition of the

celestial objects.
Reference

(female)

(male)

Katherine Johnson Vera Rubin Samantha
Cristoforetti

Marie Curie

Steve Wozniak Matt Taylor Pedro Duque Albert Einstein

Table 0: Write down the Identification of your Challenge (an unique number), the Number of your Team

(1-6) and the name of the team members, one of them with a clear role (and assigned tasks), all needed.
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Activity 1: Glossary

In order to study how and where stars form, you should be familiar with the vocabulary

used by astrophysicists. Match each key word with its definition.
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Activity 2: Measurements in Astronomy

Activity 2.1: Positions

To study an object in the sky, you first need to know its location. The position of any

celestial objects is expressed using two dimensional coordinates, just like you would use

coordinates on Earth (see Figure 3).

Figure 3: Latitude and longitude  (Credit: Wikipedia)

The coordinate systems usually used in astronomy as: the horizon and the equatorial

coordinates. The main difference is that horizon coordinates depend on the location of the

observer and the equatorial coordinates don't. Visit this web and/or watch this CESAR

video for clarification (in Spanish).

Figure 4: Horizon coordinates. (Credit:Aurge.org) Figure 5: Equatorial coordinates. (Credit: Aurge.org)
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Horizon coordinates

These coordinates consist of altitude (alt) and azimuth (az). They are also called local

coordinates, which means they are given with respect to the observer. Take a look at the

Figure 6.

Figure 6: Horizon coordinates  (Credit: Wikipedia)

Imagine you are at the “Observer” point

looking at the star.

● The altitude is the angle measured

above the horizon. This can range

from 0º (at the horizon) to 90º (just

above your head, at the zenith).

● The azimuth corresponds to the

angle on the horizontal plane,

starting from the geographical North

towards the East, until reaching your

position.

Since these coordinates depend on the observer’s position on Earth, an observer

looking at the same star from somewhere else will have different altitude and azimuth

coordinates.

Figure 7: Horizon coordinates. (Credit:Aurge.org)
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Equatorial coordinates

The equatorial coordinates are right ascension (RA) and declination (DEC). They are

independent of the observer position and are therefore called global coordinates.

Figure 8: Celestial sphere  (Credit: COSMOS)

Imagine placing the Earth inside a huge sphere,

what we call a celestial sphere. If you extend the

Earth’s equator plane all the way up to this sphere,

we obtain the celestial equator plane.

For simplicity, we consider every celestial object to

be projected onto this celestial sphere, thereby are

able to determine the position.

Just like on Earth, the celestial sphere has

longitude and latitude lines.

Figure 9: Equatorial coordinate

system.  (Credit: COSMOS)

● Right ascension (RA) can be compared to longitude on

Earth. It is measured in hours, minutes and seconds. The

reference position (RA=0) is the vernal equinox2. Note:

Since the Earth rotates 360º on its axis in 24h, one hour

corresponds to 15º.

● Declination (DEC) can be compared to latitude on Earth. It

is measured in degrees, arcminutes and arcseconds. The

reference plane is the celestial equator, and the values

are positive when the object lies north.

2 The vernal equinox is the location where we can find the Sun on the 21rst of March, which matches

with the beginning of the spring in the Northern Hemisphere (video 1, video 2)
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Sometimes astronomical catalogues give the RA and DEC coordinates entirely in degrees.

It is therefore useful to know how to convert between units.

To convert Right Ascension in hours, minutes and seconds into degrees use Equation 1:

(ℎ + 𝑚𝑖𝑛
60 +  𝑠𝑒𝑐

3600 ) ×  15

(Equation 1)

To convert Declination in degrees, arcminutes, arcseconds into degrees use Equation 2:

(Equation 2)(𝑑 + 𝑎𝑟𝑐𝑚𝑖𝑛
60 +  𝑎𝑟𝑐𝑠𝑒𝑐

3600 )

Note: When declination is negative, the arcminutes and arcseconds are too!

Activity 2.1.1: Conversion between hh:mm:ss and degrees:arcminutes:arcseconds to

degrees

A star has the following RA (h,m,s)  and DEC (degrees, arcmin, arcsec) coordinates:

(RA, DEC) = (10h 43m 56s, -59º33′00′′)

Convert these coordinates to degrees.
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Activity 2.2: Distances

There are various methods to measure the distance to celestial objects. These methods

are represented in the “cosmic ladder”, shown in Figure 10. Each method of measurements

is based on the values obtained from the previous method.

Figure 10: Cosmic ladder (Credit: ScienceWISE)

Before measuring any distances, it is important to have the units clear.

For distances within the Solar System astronomers use the

astronomical unit (AU).

1 AU corresponds to the average distance from Earth to the Sun

and is equal to .1. 5×108 𝑘𝑚

15



Figure 11: Astronomical Unit.

(Credit: NASA)

Another unit of distance is the light year (ly), used in Figure 10.

A light year is the distance light travels in a year.

Now that units are clear, here is a short description of each method used to measure

distances within the following ranges in the Universe:

● d1 (within the Solar System, )𝑑 < 10−4𝑙𝑦

● d2 (nearby stars, )𝑑 < 102𝑙𝑦

● d3 (within our galaxy, )𝑑 < 105𝑙𝑦

● d4 (nearby galaxies, )𝑑 < 107𝑙𝑦

● d5 (galaxy clusters, )𝑑 < 1010𝑙𝑦
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Method 1: radar ranging

For measurements within the Solar System ( ). It works by sending a radio wave from10−4𝑙𝑦 

Earth towards the object of interest in the Solar System, and recording the time it takes for

the wave to return.

Figure 12: Radar ranging (Credit: http://abyss.uoregon.edu/~js/ast123/lectures/lec13.html)

Method 2: stellar parallax

To measured distances to nearby stars

( ). This method makes use of the𝑑 < 102𝑙𝑦

parallax effect. In order to understand how

this works, take a look at Figure 13 and try

it yourself.

Figure 13: Example of the parallax effect

(Credit: http://blog.cupix.com/)

ACTION: Hold your thumb up in front of you, as shown in Figure 13, as far away from your

body as possible (with a comfortable posture).
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Observe the object, in this case the car, positioned in front of you, with respect to the

position of your thumb. Close one eye and repeat this. Next close the other eye instead,

always leaving one eye open.

Explain what you see:

This is what we call the “parallax effect”. By measuring the apparent shift in position of an

object (thumb) with respect to the background, arising from the fact that the object was

observed from two different positions (equal to the separation between eyes or larger)

one can calculate the distance to the object. This method is used to measure the distance

to nearby stars, and is therefore called “stellar parallax”.

Figure 14 shows the observation of a nearby star with respect to the background. In

January, the star appears to be positioned at the far right in relation to the background

stars, whilst the same observation in July shows the star at the far left.

The combination of both observations gives an estimate of the apparent shift in position of

the star.
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Figure 14: Definition of stellar parallax (Credit: Gaia/ESA/ATG medialab)

To measure the parallax distance “D” to the star, one needs a known “baseline length”. In

this case, the orbital radius of Earth around the Sun, 1 AU, is used as baseline, as shown in

Figure 14. The half-angular shift (parallax angle) between the star and the background

combined with the baseline is then used to calculate the distance.

(Equation 3)𝑡𝑎𝑛(𝑃) =  1 𝐴𝑈
𝐷

where P is the stellar parallax and d is the distance between Earth and the star.

(The word parsec comes from parallax of one arcsecond).
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Method 3: Main sequence fitting

For distances within our galaxy ( ).𝑑 < 105𝑙𝑦

To understand this method, we first explain how astrophysicists use a H-R diagram

and identify the main sequence phase on it.

In a H-R diagram, like the one shown in Figure 15, the values of the intrinsic

brightness of the objects are plotted on the y-axis and on the value of the surface

temperature of stars on the  x-axis. The H-R or Hetzsprung-Russel diagram is

named after its creators.

The main sequence is the evolutionary phase of a star in which its core burns 4

atoms of hydrogen producing 1 atom of helium. In general it is the most stable

phase of the stars, although the most massive stars leave this phase much earlier

than the less massive ones.

We can see the different evolutionary steps of stars in an H-R diagram.

The distance measurement method compares the position on the H-R diagram for a set of

stars of common origin (called a star cluster) whose distance is known, with that of another

star cluster of unknown distance.

20



Figure 15: H-R diagram (Credit: National Schools’

Observatory)

Figure 16: Difference between the apparent

brightness measured for an object (m) and its

intrinsic brightness (M) used to calculate distance.

ZAMS stands for “Zero Age Main Sequence”, which

indicates the initial point in which stars begin to

burn hydrogen in their cores, starting their life as

stars. (Credit: birmingham.ac.uk, link)
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Method 4: Measurement of distances employing cepheid variables

For nearby galaxies ( ).𝑑 < 107𝑙𝑦

Cepheid stars are a type of very luminous star that expands

and contracts periodically, varying in brightness. Their

brightness sequence is well known. These stars were

discovered by astronomer Henrietta Swan Leavitt in 1912.

Leavitt discovered and catalogued variable stars and

deduced that those of greater luminosity have longer

periods, which led her to establish the relationship between

both parameters. This discovery revolutionized the way of

observing the Universe and led to important findings, such

as Hubble's law.

Figure 17: Henrietta

Swan Leavitt (Credit:

wikipedia)

This method consists in comparing the brightness of a variable cepheid within a nearby

galaxy, to the known, intrinsic brightness of a similar star. The difference in brightness

allows us to determine the distance to this nearby galaxy.

Method 5: Distance measurements from the Tully-Fisher relation

To measure distance to galaxy clusters ( ).𝑑 < 1010𝑎𝑙
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The Tully-Fisher relation relates the luminosity of galaxies to their rotation speed. The

larger the galaxy, the faster it rotates. If one knows the velocity, one can find the luminosity

and, as with Cepheid stars, deduce the distance.

Method 6: Calculating distances from Hubble’s law

This method is ​​used to measure distances to distant galaxies. It consists of measuring the

velocity at which galaxies move away and thus estimate their distance. Hubble's Law

relates the velocity ( ) at which galaxies move away to the distance at which they are𝑣

located ( ) and the Hubble constant .𝐷 (𝐻
0
)

(Equation 4)𝑣 =  𝐻
0
𝐷

Figure 18: Hubble’s law (Credit: Space FM)
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Activity 2.2.1: Conversion between units of length (longitude)

1. Using the trigonometric relation between parallax and distance, answer the

following question:

At what distance (D), in astronomical units (AU), will an object at 1 parsec be?

2. Convert 1 light year (ly) into kms:

Hint 1:

1 year = 365 days

1 day = 24 h

1h = 60 min

1 minute = 60 seconds

Hint 2: Light travels at 3 × 105 𝑘𝑚
𝑠
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3. Use what you have learnt about the different astronomical distance units to

calculate how far the following objects are from Earth. What units make sense for

each object in Table 1?

Object Astronomical
units (AU)

Light years (ly) Parsec (pc)

Jupiter 0.00008175

Sun 0.000004848

Proxima
Centauri

268142.2

Orion Nebula 412

Eagle Nebula 7000

Carina Nebula 7500

Andromeda 2 500 000

Table 1: Calculating distances.

4. Why does using different units depending on the object or region of the sky make

sense?

5. What units would you use to quote distances within the Solar System?

6. What units would you use to quote distances to a stellar cluster?
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Activity 2.3: Sizes

Having found the distance to the Sun, the Orion and Carina Nebula etc in Activity 2.2.1, we

can now find how big these objects or regions on the sky are.

The size of an object in astronomy is given as the “angular diameter” as seen from Earth,

instead of their actual sizes. To understand this better, take a look at Figure 19, which

shows an observer looking at the Moon. The Moon is at a distance D from the observer.

The actual diameter of the Moon is d and the angular diameter for the observer is .δ

Figure 19: Representation of angular and

actual (linear) sizes (Credit:

https://lonewolfonline.net)

Looking at Figure 19, and with your understanding of trigonometry, you can relate the

angular size, the linear size (or actual size), d, and the distance to the object (the Moonδ,  

in this case)  D, as follows:

(Equation 5)𝑡𝑎𝑛 δ =  𝑑
𝐷     

The angles we are dealing with are usually very small so we can make use of the small

angle approximation:

(Equation 6)𝑡𝑎𝑛 δ ≈ δ
where is in radians.δ
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In astronomy,  angles are usually given in arcseconds, so to transform radians to

arcseconds we should take into account that:

✔ 2 rad = 360 ° π

✔ 1 ° = 60‘ = 3600 arcseconds

Therefore to express in arcseconds, we should use Equation 7:δ

(Equation 7) δ 𝑎𝑟𝑐𝑠𝑒𝑐𝑜𝑛𝑑𝑠( ) =   3600'' 
1º × 360º

2𝜋 𝑟𝑎𝑑 × 𝑑
𝐷  =  206265'' × 𝑑

𝐷  

1. Calculate the Sun’s actual size, with the following information:

a. The Sun’s angular diameter is: δ = 0. 5º

b. The mean distance between the Sun and Earth is: D=150 000 000 km

WARNING: Never look at the Sun with the naked eye.

Activity 2.3.1: Estimating angular sizes with your hands

Did you know that by holding your hand out as shown in Figure 20 and 21, you can

estimate the angular diameter of objects?
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Figure 20: Measuring angular sizes (Credit:

https://www.exploratorium.edu/)

Figure 21: Estimation of angular diameters

(Credit: www.daviddarling.info)

Tonight, try to measure the Moon’s angular size in degrees. Repeat this exercise during a

month and check your answers.

Activity 2.4: Magnitudes

Astronomers use the concept of magnitude to express how bright a celestial object is.

Magnitude is just a number, but it is counterintuitive; the lower the magnitude of a star,

the brighter it is!

Note: The very, very bright objects even have negative magnitudes!

The distance to an object plays a role in how bright it looks to us. Imagine two identical

flashlights shining at you, one from 1 m away and another from 20 m away. The former will

of course look brighter to you even though they are the same. This also happens with

stars.

Figure 22: Lightbulb (Credit: Shutterstock)

To avoid this distance factor, astronomers use apparent magnitude.
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Hipparchus of Nicaea was a Greek astronomer, 2000 years ago, who classified stars in

terms of how bright they appeared in the sky and grouped them into six categories. The

brightest stars had magnitude 1 and the faintest, magnitude 6.

Figure 23: Representation of Hipparchus de

Nicea (Credit:  https:// cienciaes.com)

Today, the method has changed slightly, and

we know that between the “1st” and “6th

magnitude” stars there is a factor of 100 in

brightness.

That means, between each interval in

magnitude, brightness decreases by a factor

of or . A magnitude 1 object will5 100 2. 512

be 2.512 times brighter than a magnitude 2

object and times brighter than a2. 5122

magnitude 3 object.

This can be summarized by Equation 8,

(Equation 8)𝑚 =  − 2. 5 𝑙𝑜𝑔 𝐹 +  𝑐𝑜𝑛𝑠𝑡

where F is the object’s brightness.

With this new method, objects can also have negative magnitudes. Such objects are even

brighter than Hipparcus’ original “1st magnitude” stars.
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Therefore, the apparent magnitude does not necessarily describe how bright the object

actually is. Figure 24 and 25 show the example of the Sun and Vega, the fifth brightest star

in the night sky. The Sun has a much lower apparent magnitude and therefore appears to

be many times brighter than Vega, when actually Vega is 57 times brighter than the Sun.

The problem is it's just further away.

The Sun, apparent magnitude = -27

Figure 24: Image of the Sun (Credit: ESA/SOLO)

Vega, apparent magnitude = 0.03

Figure 25: Image of Vega (Credit: Wikipedia)

Activity 2.4.1: Filters

As you saw in Activity 2.4, magnitudes are used to express how bright objects are.

Telescopes provide magnitude data by looking at stars through different filters.

Imagine a star emitting in the visible range (like our Sun). Without a filter, this emission will

appear white. However if we were to use a telescope’s red filter, the filter would block light

of all colours except red.

The magnitude of that star, measured through the telescope with this filter will therefore be

the red-band magnitude.
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Figure 26: Red-filter (Credit: VisonDoctor.com)

Telescopes also measure magnitudes with green (g), ultraviolet (u), and infrared (i) and

many more filters, such as H-alpha.

Whenever we give a magnitude value, we must specify what filter it corresponds to.

Activity 2.5: Colour

Activity 2.5.1: What colour are stars?

You may have noticed when looking up at the

night sky, that not all stars appear to have the

same colour, and that is correct!

Some stars look red, others blue, yellow… due

to their different emission temperatures, see

Figure 28.
Figure 27: Trails in the night sky of Teide (Credit:

Daniel López)
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Figure 28: Different coloured stars. (Credit:

http://www.mstworkbooks.co.za/natural-sciences/gr9/gr9-eb-05.html)

The colour of stars we see depends on the peak wavelength at which they are emitting

(emission peak).

The energy distribution of a body can be compared to that of a black body. In this way

one derived the effective temperature of it.

In Activity 5.2 you will be able to learn about these concepts in more depth using a

simulator.

If you want to experiment how different we may see the colour of the stars, take a look at

this CESAR Scientific Case about “What are the colours of the stars?”.

The problem with colour is that what might appear blue to you, might appear less blue to

someone else. To solve this issue, astronomers came up with a precise definition for

colour, one that everyone agrees on and which can be compared.

Activity 2.5.2: Colour in astronomy
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Comparing the magnitude of an object observed with a red filter to the magnitude

observed with a blue filter, we will find out whether that object emits more in a redder or

bluer band. (Note: remember from Activity 2.4, that the brighter the object, the lower its

magnitude).

Subtracting these magnitudes from each other gives you the colour of the celestial

object.

Figure 29 shows the Sloan filters from which you may obtain the following colours:

(u-g) colour (r-i) colour

(g-r) colour (i-z) colour

where (u) is ultraviolet, (g) is green, (r) is red, (i) is infrared and (z) is far infrared. If the

(u-g)>0, the magnitude in the u band is larger than in the g band. This means the object is

greener (given it is emitting at a longer wavelength).

Figure 29: Sloan filters of the instrument

MegaCam in the CFHT telescope. (Credit:

cfht.hawaii.edu)
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1. Compare the (g-r) colour of the Sun and the star Vega. What does the result tell you

about the emission of the Sun and Vega in the g and r magnitude band?

The Sun
(g-r) = 0.44

Figure 30: Image of the Sun (Credit: ESA/SOLO)

Vega
(g-r) = -0.25

Figure 31: Image of Vega (Credit: Wikipedia)

2. Compare the (u-g) colour of the Sun and the star Vega. What does the result tell you

about their emission in the u and g magnitude band?

The Sun
(u-g) = 1.43

Vega
(u-g) = 1.02

Activity 2.5.3:  Colour-colour diagrams

As one can deduce from the name, this type of diagram compares many colours of an

object (or many) at the same time.
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1. Go back to Activity 2.5.2 and note the (u-g) and (g-r) colours of the Sun and the star

Vega. Plot these onto this colour-colour diagram:

Figure 32: Example of a colour-colour diagram from the Sloan Digital Sky Survey (Credit: SDSS)

2. Reading Figure 32, what type of stars are the Sun and Vega categorized as?
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Activity 3: How much do you know about how stars form?

1. How many stars do you think are in the Universe? Take a guess!

2. Before starting to read about star formation, take a guess on what “ingredients”

may be necessary to form a star!

Figure 33: Cauldron (Credit: ClipArt)

Stars have life cycles just like the life cycle of a butterfly.

You will soon find out all the details!

Figure 34: Butterfly cycle (Credit: Pinterest)
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3. The star formation process can be divided into phases as shown in the road cartoon

in Figure 35. Order the images (a-e) in Figure 36, from the initial evolutionary stage

of the star to the latest one of formation:

Figure 35: Overview of the steps of star formation (Credit: adapted Freepik)

Figure 36: Basic steps of star formation  (Credit: ESO Supernova)

4. Watch this video to get the hints about the star formation processes.
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Activity 4: Star formation in detail

Have a look at Figure 37, where the various stages of the star formation process (that you

watched in the previous video) are represented.

Figure 37: Overview of the steps of star formation. (Credit: https://kids.frontiersin.org/)

1. Explain in your own words what you understand about the different star formation

stages.
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Here are the evolutionary phases that take place in the star formation process more in

detail.

Before the star formation begins …

PHASE 1: The molecular clouds

Figure 38: Molecular cloud.

(Credit: https://kids.frontiersin.org/)

As we saw in Activity 1, the interstellar medium (ISM) is

the matter and radiation that occupies

the space between the star systems in a galaxy… Most

of the mass of the interstellar medium (as gas, dust and

cosmic rays) is contained in regions called molecular

clouds. Molecular cloud are composed primarily of

hydrogen molecules and helium atoms and can contain

more mass than 100 000 times the Sun. You can fit our

entire Solar System 10 000 times in a cloud!

Figure 39: The Orion Nebula (Credit: Wikipedia)

There are bright and dark clouds (also called nebulae). Bright nebulae can be further

split into two types: emission and reflection nebulae. Emission nebulae absorb photons

and re-emits them at longer wavelengths, while the reflection nebulae just reflects nearby

light.
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Figure 40: Emission, Reflection and Dark Nebulae (Credit: COSMOS and adapted from glyphweb)

PHASE 2: From clouds to filaments

The material in the molecular clouds moves around constantly in every direction. You can

compare this material to stars in a busy city. In regions where matter is most concentrated

(like in a traffic jam), filament structures form.

Figure 41: Particle movement in clouds. (Credit:

https://www.sciencelearn.orgy)

Figure 42: Traffic jam (Credit: Rabinky Art)
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Figure 43: Star-forming region Orion B (Credit: ESA/Herschel/NASA/JPL-Caltech, link)

PHASE 3: From filaments to clumps

Within these filaments, matter starts to pile up, producing very dense regions. A point is

reached in which the gravitational force of these regions is so strong, it takes over,

becoming the dominating force, and these regions fragment into warm clumps as shown

in Figure 44.

Figure 41: Clump fragments (right image: Credit: Adapted version of the Star-forming region Orion B

(Copyright: ESA/Herschel/NASA/JPL-Caltech, left image Credit: 2014 Pearson Education, Inc)
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These clumps are so dense that they collapse over their own gravity, as shown in Figure

45 and 46. During the collapse, clumps accumulate more and more matter from the

surrounding cloud.

Figure 45: Building collapsing (Credit: Builders

Enquiry)

Figure 46: prestellar core gravitational collapse

(Credit: https://kids.frontiersin.org/)

Once the star formation begins …

PHASE 4: From clumps to cores

The movement of particles within the clump causes it to spin. The collapsing occurs

quicker in the denser, center region, which leads to even more material (mostly molecular

hydrogen) to be driven towards the center. As more and more material concentrates in the

middle, the clump spins faster and faster (just like when a ballerina brings in her arms to

spin quicker). This phenomenon is called conservation of angular momentum.

Figure 47: Top: Conservation of angular momentum (Credit: Lumen Learning). Bottom: Clump gets denser,

hotter, and spins faster as material concentrated in the centre.
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The increasing density raises the temperature, forming a

hot centre that is so dense, it is referred to as a core.

Once this core reaches a temperature of 30 000K, it is

called a pre-stellar core.

Figure 48: Prestellar core gravitational

collapse (Credit: https://kids.frontiersin.org/)

PHASE 5: From cores to protostars

The core has been accumulating material from the surroundings, becoming denser and

rotating faster whilst collapsing. A gravitationally collapsing sphere surrounded by material

creates a flattened spinning disk (just like the ballerina’s tutu behaves when she turns).

This flattened disk is called an accretion disk.

Figure 49: Top: The ballerina’s tutu is lifted,  parallel to the floor while she turns (Credit: link). Bottom: Material

around core being flattened into a disk.

43

https://scienceblogs.com/startswithabang/2013/05/10/where-does-an-earthquakes-energy-come-from


The pre-stellar core is now known as a protostar and

the accretion disk will be essential for its evolution.

The protostar grows from the material that falls in

from the disk moving inwards towards its surface.

This acquisition of material is called accretion.
Figure 50: Prestellar core gravitational

collapse (Credit: https://kids.frontiersin.org/)

Watch this video about accretion disks and see what other types of objects do have

accretion disks, apart from the protostars.

Stars that form at the same time within a molecular cloud form group called stellar

cluster. If these stars are young, the cluster is known as an open cluster, whilst if they are

evolved, older stars, they belong to a globular cluster. Stars within the same cluster will

all be at the same distance from Earth, be of the same age and have the same chemical

composition at the beginning. The difference between the stars is their mass. Protostars

with a higher mass will evolve faster than their lower mass neighbours. This will

differentiate them and will result in the classification of stars into different types, defining

their position in the H-R diagram as seen in Activity 2.2.

PHASE 6: From protostars to classical T Tauri stars

During the first 100 000 years star formation takes place inside cocoons of gas and dust.

The details of this process are hidden for the naked eye (in the visible), however one can

detect the protostar’s emission from the absorbed and then re-radiated emission at longer

wavelengths by the material in the envelope.

44

https://kids.frontiersin.org/
https://youtu.be/aobCaLHlzFg


Figure 51: Representation of view through the envelope surrounding the protostar during the first 100 000

years. (Credit: https://www.sciencemag.org/news/2014/02/close-look-young-star-finds-chemical-surprise)

Figure 48: Left: Two protostars detected by ESA/Herschel in the Orion star forming region. FIR4 is still a

cocoon while FIR3 has a visible jet (Credit: B.González-García et al, A&A 2016, 596,26, ESA/Herschel and the

HOPS Team). Right: Tauri star and prestellar core gravitational  collapse (Credit: https://kids.frontiersin.org/)

After 100 000 years, the gas and dust surrounding the protostar disappears.  The gas and

dust settles onto the accretion disk or is ejected in jets or outwards in both directions

perpendicular to the accretion disk, following the magnetic field lines (called bipolar jets).

This allows the conservation of angular momentum. For the first time the envelope

surrounding the protostar is lifted and the protostar can be seen for the very first time.
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PHASE 7: From classical T Tauri to weak line T Tauri stars

After several million years, the reservoir of material in the accretion disk is running low,

and the accretion onto the star slows down, which weakens its emission and gives name

to this stage: weak line T Tauri stars.

Figure 53: T Tauri star (Credit: https://kids.frontiersin.org/) Figure 54: Weak line T Tauri star (Credit: Adapted

version of https://exoplanet.mtk.nao.ac.jp/eng/seeds)

PHASE 8: From planetary debris disk to planetary disk

The disk becomes what is called a debris disk, and the remaining clumps of matter within

the disk start to agglomerate together forming larger and larger bodies (just like when you

make a snowball), called planetesimals. These clumps increase in size, attracting

surrounding material and forming what will eventually become a planetary system (disk)

like the Solar System (with planets).

Figure 55: Planetary system. (Credit:

link)
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PHASE 9: From protostar to star

Whilst the debris disk becomes a planetary disk, the protostar continues to contract and

heat up in what is called the pre-main sequence star.

As shown in Figure 56, depending on the initial mass of

the protostar (in solar masses) the star at the main

sequence phase will have a specific size, luminosity

(brightness per area) and surface temperature.

The protostar achieves the main sequence phase when

its core reaches enough temperature to ignite

hydrogen. At this point in time, the protostar has

become a star.

Figure 56: H-R diagram (Credit: stackexchange.com , link)

Figure 57: Image of the Sun collected by the ESA

misión Solar Orbiter (Credit: kyandtelescope.org)

Figure 58: Young stellar system (Credit: SPITZER)

Now that you have read about the star formation steps in more detail, review your initial

answer about how star formation occurs in Activity 3.
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Activity 5: Light from stars

Activity 5.1: Electromagnetic radiation

Figure 60: Properties of the electromagnetic spectrum. (Credit: Wikimedia Commons)
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The electromagnetic spectrum includes, from longer to shorter wavelengths: radio waves,

microwaves, infrared, visible light, ultraviolet, X-rays and gamma rays. The length of these

wavelengths are compared with recognizable objects for us in Figure 60.

Human eyes can only see light in a small range, called visible light. However some animals

can also see in the ultraviolet (some birds) and in the infrared range (nocturnal animals).

With the aid of Figure 60, test your knowledge about electromagnetic radiation by filling

the gaps:

1. Microwaves, gamma rays, and radio waves are some types of ________
________.

2. Light is composed of _________ electric and _________ fields perpendicular to

the direction of propagation of light.

3. _________ waves have the longest wavelength.

4. Gamma rays have the highest ____________.

5. The human eye can only see ________ light.

Different wavelengths provide us with various characteristics of the emitting objects.

Activity 5.2: Spectral Energy Distribution (SED)

Warm things emit light, you included!

Similarly, stars emit at different wavelengths

depending on their temperature and energy.

Figure 61: Infrared emission (Credit: Wikipedia)
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By plotting the energy we receive from a star as a function of wavelength, we can find out

in what wavelength range it is mostly emitting. Comparing its distribution with a

blackbody3 spectrum we can infer the peak temperature of the star, see Figure 62.

Figure 62: Blackbody simulator (Credit: het.colourado.edu)

Play around with this blackbody spectrum simulator and explain what you see when you

select the light bulb, the Sun and Sirius A as emitting objects.

(Tip: You can zoom in and out on either axis to see the distribution clearer)

For a Light bulb:

For the Sun:

For Sirius A:

3 https://en.wikipedia.org/wiki/Black_body
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The distribution of energy of an object plotted as a function on wavelength is called its

Spectral Energy Distribution (SED). Figure 63 shows the SED of the Sun as well as the

SED of a Sun-like star compared to that of a brown dwarf.

Figure 63: SED of the Sun (left) and SED of a Sun-like star compared to a brown dwarf (right).  (Credit:

Science Journal. 8. S113-S121. 10.2481/dsj.IGY-018. )

By looking at Figure 63, answer the following questions:

1. What type of electromagnetic radiation is the Sun mainly emitting in?

2. What type of electromagnetic radiation is a brown dwarf mainly emitting in?

Note: A brown dwarf is called a failed star because it never reaches hydrogen fusion. The

reason behind this is the brown dwarf’s initial mass is insufficient for gravity to result in a

core temperature high enough to fuse hydrogen.
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Activity 5.3: What can we learn about forming stars from their light?

A forming star will be radiating energy as well as the surrounding disk. Each

energy-radiating component of the system (protostar, disk, envelope) will occupy a certain

region in the SED depending on the wavelength it is emitting in. This is shown in Figure 64.

+ =

Figure 59: Examples of SED (Credit: Zadelhoff, G.-J. (2002). Shaping

disks; A radiative transfer and gas abundance study of circumstellar matter. )

As the disk evolves and runs out of material, its contribution will decrease until only the

star is emitting energy (like in the Sun). From the star and disk contribution on the SED, we

are able to tell in what stage of the formation process the star is in.

Star formation SEDs are classified into four classes depending on their emission

profile.

Each class corresponds to an evolutionary stage within the star formation process.

● Class 0: earliest stage of star formation, no clear contribution of the disk or star,

● Class I: the particles in the disk absorb light from the protostar and re-emit it at

longer wavelengths (infrared excess). The protostar’s contribution to the SED is

barely noticeable at this stage,

● Class II: the protostar becomes visible in the optical, there is also infrared excess

emission from the disk. This is the classical T Tauri stage,

● Class III: the disk is running out of material, the SED is mostly dominated by the

protostar and the contribution of the disk is very weak. This is the weak-line T Tauri

stage.
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Figure 65:  Describing and

classifying the evolution of a

protostar. (Credit: Harvard

astronomy, link)

1. Review Activity 4 and Figure 37 where star formation processes are described.

2. Compose and match the SEDs of classes I, II and III by:

a. Taking a star and a disk contribution to form the complete SED from Table 2.

b. Matching the SED you built to the corresponding SED in Table 3.

Hint 1: For step 2.b, bear in mind that SEDs are presented as a function of wavelength (λ)

in Table 2 and as a function of frequency (ɣ) in Figure 65 (and Table 3).  (ɣ = c/ λ, where c

is the speed of light)
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Hint 2: Remember, with time, the material in the disk runs out, the energy re-emitted from

the disk is reduced and the star’s energy dominates the SED.

Star contribution Disk contribution

Table 2: Disassembled SEDs into star and disk contribution (Credit: Preibisch 2020)
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Insert your solution obtained with Table 2 here:

Table 3: SED classes (Credit: Harvard astronomy, link)
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Activity 6: How do astrophysicists detect star formation?

We have learnt about the different steps of star formation and how to read an SED of a

forming star. The next step is to learn how to differentiate between forming and already

existing stars. When astrophysicists look for star forming regions, they try to detect the

radiation coming from the prootstars and their disks. In particular they search in three

electromagnetic emission ranges. These emissions are known as “star formation tracers”.

Figure 66: Light dispersion (Credit: Wikipedia)

These star formation tracers are: Halpha detection in the visible, with specific

characteristics, excess of infrared, and X-ray emission.

Figure 67: Magnifying glass (Credit: CanStockFoto)
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Detection
method

Explanation Image Wavelength

Halpha
emission

This occurs when accreted material

falls onto the protostellar surface,

channelled by the stellar strong

magnetic field which accelerates

the gas and leads to Halpha

emission. When an electron is

recombined with a hydrogen atom

and falls from level 3 to level 2, it

emits Halpha.

656 × 10−9𝑚

Infrared
excess

Infrared excess is caused by the

dust particles in the accretion disk

which absorb light from the central

protostar and re-emit it at longer

wavelengths. The detection of

infrared excess is a well known

tracer for the presence of a

circumstellar disk.

800 − 2500 × 10−9𝑚

X-ray
emission

The X-ray emission results from

accretion shocks as well as from

gas on the protostellar surface

being heated to such high

temperatures, it emits in X-ray.

0. 5 − 2. 5 × 10−10𝑚

Table 4: Star formation tracers
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Identify the region in the spectrum corresponding to infrared, Halpha, and X-ray emission

and label these on Figure 68.

Figure 68: Electromagnetic spectrum showing wavelength in meters (Credit: VectorStock)

Figure 69, shows the percentage of light being absorbed by the atmosphere depending on

the wavelength.  An opacity of 100% means the atmosphere is blocking light from entering

Earth.

Look at Figure 69 and think about whether the wavelengths used to study star formation

can be detected from Earth or one needs to observe from outer space?

Hint: the emission ranges for star formation detection are visible, infrared and X-rays.

Figure 69: Atmospheric opacity (Credit: NASA)
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Each star formation tracer is not enough alone, one needs to combine the three to obtain a

reliable result. The following chart shows why:
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Activity 6.1: Halpha emission

Halpha emission occurs in hydrogen, which has the atomic symbol H. Hydrogen is the

most simple atom in the entire Universe, made up of one proton forming the nucleus and

one orbiting one electron. Here is a simple version of the hydrogen atom:

Figure 70: Hydrogen atom (Credit:

VectorStock)

Imagine our electron finds itself in orbit 2. Then the hydrogen atom interacts with

surrounding light. This incoming light meets the electron and gives it a small present (some

energy!). The electron very happily accepts the present and absorbs the energy, this

makes it jump out of its orbit, leaving the hydrogen atom.

Hydrogen is now said to be ionized and is called HII (pronounced H-two).

We can think about the hydrogen atom as a “solar system” where the Sun is the nucleus

and the electron is the planet orbiting around it. The electron may orbit the nucleus at

various orbits and these orbits are each given a number and have an energy assigned.

After some time, the atom recaptures the electron. The electron enters the atom and may

stop at different orbits before it returns to its original one. In this case our electron returns

to the atom and stops for a while at level 3.
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Nature  tends to a state of equilibrium, or low energy, therefore the electron will move from

orbit 3 to orbit 2. This transition leads to the emission of a photon (i.e. energy in the form of

light), as shown in Figure 71.

The light emitted has a wavelength of 656 nm. This emission is called Halpha emission

and corresponds to red light.

Figure 71: Absorption and emission of light leading to Halpha emission

Remember, we are in the visible region of the electromagnetic spectrum when we talk

about H emission.α

The process of absorption and emission leading to Halpha emission can be detected in the

hydrogen absorption and emission spectrum (Figure 72).

An absorption spectrum is produced by shining white light (composed of all visible

wavelengths) through an emitter across a colder medium (gas). The energies (or

wavelengths) absorbed by the atoms will show up as a black gaps on the spectrum. The

photons with these energies have been absorbed and therefore do not show.
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Figure 72: Emission and absorption spectrum when passing through hot and cold gas. (Credit: Byjus)

Figure 73: Hydrogen absorption spectrum  (Credit: Siyavula)

When light from an emitter passes through hot gas, electrons become excited. When these

return to a lower energy state, they emit light, leading to emission lines.

Figure 68: Hydrogen emission spectrum  (Credit: Siyavula)

Figure 75 shows the Sun’s absorption spectrum. Notice any similarities with the one of

hydrogen (look at Figure 74)?
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Figure 75: Solar spectrum (Credit: Studying the Sun, Charlie Fagg.)

That’s right! The Sun also absorbs in the Halpha wavelength!

The Halpha wavelength can be calculated thanks to the Danish physicist Niels Bohr, who

came up with the idea of treating the hydrogen atom as a planetary model and developed

an equation to calculate the wavelength of the emission originating from the movement of

electrons between orbits.

(Equation 8)
1
λ = 𝑅

𝐻
1

𝑛
𝑓
2 − 1

𝑛
𝑖
2( ) 

is the Rydberg constant and is equal to , is the final orbit the𝑅
𝐻

1. 097 × 107𝑚 −1 𝑛
𝑓

electron falls to (in the case of Halpha, it is equal to 2) and is the initial orbit from which𝑛
𝑖

the electron falls (in the case of Halpha, it is equal to 3).

1. Use equation 6 to calculate the wavelength of Halpha emission.

Read through Table 4 to remember what leads to Halpha emission in star formation.
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The intensity of the Halpha emission can be obtained from photometry (extraction of the

detected flux or magnitude of an object from the photons collected by the CCDs of an

instrument with a Halpha filter), as we have seen in the VST catalog.

Another method of measuring the intensity of the Halpha line (or any other transition line of

another chemical element) is from its emission lines.

Spectral lines are the result of passing

light from an object through a slit or

diffraction grating, called a

spectrograph.

You can check out different

spectrographs by clicking on this link

and reading Section 3.3.

Figure 76: Equivalent width (Credit: Hopkins Phoenix Observatory)

The size of spectral lines indicates the strength of the emission and is measured as a

function of equivalent width (EW).

The equivalent width of an emission line measures the area below the curve and is

approximated as a rectangle, as shown in Figure 76.

When you don’t have an emission spectrum, but rather have catalogue photometric data

like we do, one can use the photometric equivalent width, which also measures the

strength of an emission.
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The photometric equivalent width is given as

(Equation 9)𝐸𝑊
𝐻α

=  𝑊 × [1 − 10
0.4×(𝑟−𝐻α)

𝑒𝑥𝑐𝑒𝑠𝑠]

where represents the equivalent width, is the width of the filter being used and𝐸𝑊
𝐻α

𝑊

is the excess of colour.(𝑟 − 𝐻
α
)

𝑒𝑥𝑐𝑒𝑠𝑠

Activity 6.2: Infrared emission

Take a look at Table 4 to remind yourself about why infrared excess occurs in star

formation. Infrared emission appears on the SED and tells astronomers the disk is present.

By plotting colour-colour diagrams, astronomers

can study the excess infrared emission originating

from the disk. Such a plot is shown in Figure 77,

where the three different infrared wavelength

bands called J,H,K have been used to compute

colour.

Figure 77: Colour-colour diagram (Credit: Preibisch)

Figure 78: Wavelength ranges for

J,H,K filters (Credit:

http://www.rem.inaf.it/remir.html)
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Take a look at Figure 77. As we previously saw in Activity 2.5.2, infrared excess would arise

if:

(J-H)> 0, (H-K)>0

Full grown stars with no accretion disk, show no infrared excess (green symbols) and

occupy a very specific region in the plot which can be delimited by the dotted lines.  Every

object that falls to the right of this limiting region,

(H-K)>0, H>K

is considered to show infrared excess (red symbols). This is because objects to the right

have a smaller K value (and are therefore brighter in the K band). Since the K band has the

longest wavelength it can be thought as being “more in the infrared”. Therefore these

objects have an “excess” of infrared emission.

Note: Remember, the lower the magnitude, the brighter the object emits in that

wavelength.

Activity 6.3: X-ray emission

Similar to our Sun, protostars have magnetic field lines. With the rotation of the protostar,

these lines get tangled, just like when you twist a rubber band many times. This

entanglement creates loops, which interact with the gas on the protostar’s surface and

heats the gas up to millions of degrees.
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Figure 79: Sun’s magnetic map (Credit: Solar Orbiter)

Check out this video to understand the process better.

X-ray emission is also found to originate from accretion shocks but at a smaller scale

compared to the X-ray from the magnetic activity.

Figure 81: Magnetic Loops on

protostar surface (Credit: link)

Figure 80: X-ray emission in protostars through accretion
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We have learnt how to identify star forming candidates from their Halpha,

infrared excess and X-ray emission.

However you must take care because other objects in the Universe also emit

this type of emissions and may be wrongly classified as forming stars. For

example: Black holes are also surrounded by an accretion disk and emit X-rays,

as well as emitting in the infrared or visible parts of the spectrum.

Activity 7: Star formation exploration

The European Space Agency has a wide variety of scientific missions studying the

Universe and contributing greatly to the international scientific community. One of the

topics explored by ESA is star formation, seen in Activity 6. In this Scientific Case we will

use data from three important ESA missions related to star formation: XMM-Newton, GAIA,

and Herschel.
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Activity 7.1: Star formation exploration by the European Space Agency

Mission: XMM-Newton

Observational range: m1 − 120 × 10−10

The name of this space mission is composed of

two factors. “XMM” stands for X-ray Multi-Mirror.

“Newton” is in honour of the great physicist and

mathematician Sir Isaac Newton. It was launched

by the vehicle Ariane 5 and placed into orbit in

1999. It is currently fully operational. The Earth’s

atmosphere blocks X-rays (thankfully) so the only

way to detect them is by having detectors in space.

XMM is the largest, scientific satellite ever built in

Europe ( ) and helps scientists∼ 11 𝑚 × 16 𝑚

unravel the secrets of our Universe at very high

temperatures (millions of degrees). For example,

how galaxies form, how black holes interact with

their environment or how star formation occurs. For

this purpose, it carries 7 scientific instruments on

board (camaras, X-ray spectra, radiation meter, and

an optical-UV monitor).

Want to learn more? Check out this video!

Figure 82: XMM-Newton (Credit: ESA)

Mission: GAIA

Observational range: 330 − 1050 × 10−9𝑚

GAIA is an European Space Agency satellite observing

the sky. This satellite is capable of identifying more109

stars than its predecessor, Hipparcos. It identifies the

distance to these objects (parallax method studied in

Figure 83: GAIA (Credit: ESA)
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Activity 2.2), their position, radial velocity, and

photometry… Studying the variation in position of stars

and other celestial objects allows us to understand their

trajectories and in some cases their origin as well as to

identify “sister stars”, with the same chemical

composition and of the same age, which have dispersed

throughout the galaxy (for example: sister stars to our

Sun). Check out this video to learn more about GAIA!

The dotted lines you observed on Figure 84 emerging

from the sources detected by GAIA show their

trajectories, at 90º to the vision line between us and

them.

Figure 84: Stellar trayectory

Mission: Herschel

Observational range: 55 −  672 × 10−6𝑚

The Herschel Space Observatory, operated by the

European Space Agency, has been the space telescope

with the largest main mirror (D = 3.5 m) put in orbit. Since

infrared observatories need to be refrigerated, their life

expectancy will depend on how the refrigerating liquid

conserves its properties. For Herschel, the satellite

operated from 2009 until 2013. It’s aim was to study the
Figure 85: Herschel (Credit: ESA)

coldest and most distant objects in the Universe as well as in our galaxy, with main focus

on star and galaxy formation and interaction with the interstellar medium. Herschel was

sensitive to the radiation from the cold dust in molecular clouds and was therefore able to

image these regions, known as “stellar nurseries”.

Check out this video to learn more!

Here are the various ESA missions. You can look at the full sized image under this link.
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Figure 86: ESA missions (Credit: ESA)

Collaboration between space agencies over the world helps scientific research move

faster. Researchers usually make use of data obtained through various missions. In this

Scientific Challenge you will use data from other space agencies like the European

Southern Observatory (ESO) combined with ESA data to reach our goal: explore star

formation.

Activity 7.2: Star formation exploration by ground based observatories

Mission: 2MASS

Observation range: m1. 25 −  2. 17 × 10−6

2MASS, which stands for 2 Micron (=micrometer) All Sky Survey. The data obtained was

the result of a collaboration between many American organizations, including NASA

(1997-2001). By using two telescopes, observing in the infrared,  one in the northern

hemisphere (United States) and one in the southern hemisphere (Chile).
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2MASS mapped more than 300 million objects in the near-infrared. The catalogue included

brown dwarfs, low mass stars, galaxies, and stellar nurseries where stars form.

The spectral range used was the J,H and K band (review Activity 6.2) which have the

following wavelengths:

Band Main wavelength

( )× 10−6 𝑚
J 1.25

H 1.65

K 2.17

Figure 87: 2MASS survey (Credit: Caltech)

Table 5: 2MASS bands

Mission: VLT and VST

Observational range: m300 −  1100 × 10−9

VLT stands for Very Large Telescope. It is on the observatories run by the European

Southern Observatory and is located in Chile (Paranal). It is composed of 4 telescopes,

with 8 meters of diameter, with the most advanced instrumentation in the visible range.

Each telescope has an angular resolution of 50 milliarcseconds (like seeing a DVD held by

an astronaut at the International Space Station!).

When all 4 telescopes work at the same time, they can reach a resolution of up to 2

milliarcseconds. The VLT is responsible for many breakthroughs such as obtaining the first

image of an exoplanet or the study of how stars behave around a massive black hole. The

array of telescopes started working in 1999.
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Since 2011, these four telescopes have been

supported by another telescope called VST, which

stands for the Very large Survey Telescope. This 2.6 m

in diameter telescope is used to map regions in the

sky and produce surveys and stellar maps.

The sensitivity of this telescope’s camera allows the

study of young stars in the process of accreting as

well as finding out more about molecular clouds.

The VST camera has 5 filters which are used to

measure magnitudes and study colour of objects (see

Activity 2.5.2 about colour) in 5 different bands:

Band Main wavelength ( )× 10−9 𝑚
Ultraviolet  (u) 354.3

Green (g) 477.0

Red (r) 623.1

H-alpha 658.8

Near Infrared (i) 762.5

Table 6: VST bands

Figure 88: VST (Credit: ESO)

Check out this video to learn

more!
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Science works through collaborations between

scientists and missions. The scientific data from the

European Space Agency are accessible through the

free, scientific portal called ESASky. This portal allows

scientists and astrophysics amateurs to access this

data, as well as use it for educational and scientific

communication resources.

ESASky gives access to scientific data from ESA

scientific, spatial missions and step by step will

contain data from Earth observatories from 2MASS or

ESO.

Figure 89: ESASky (Credit: ESDC)
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Phase 2
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Activity 8: What have you learned so far?

Answer this quiz to evaluate your learning.

Activity 9: News
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Phase 3
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Your mission

We have seen the different steps needed for a star to form. We learnt that

● A protostar accretes material from its surrounding accretion disk until the disk runs

out of most of its material

● The disk from which the protostar feeds provides material for roughly 1 to 10 million

years

● During the main phase of accretion the protostar is known as a classical T Tauri star.

The accretion process can be detected as H emission.α

● After that, the disk is depleted and the protostar becomes a weak line T Tauri.

The mystery is that astronomers have found H emission from protostars that are 30α 

million years old, that no longer have an accretion disk. But how is that possible? This

observation seems to contradict the theory, and when such contradictions occur in

science, the only way to find an explanation is to conduct our own research!

Your mission is to help us understand what is happening. Through the following activities,

you will look for classical T Tauri stars in Trumpler 14 and try to find out whether your

observations agree with the ones by the astronomers or with the theory we have learnt.
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Activity 10: The Carina Nebula

In this Scientific Challenge we will be researching a particular region in the sky, the Carina

Nebula. Read the following passages about this region and extract as much information as

you can find! Summarize your findings in the space below the 4 texts.

Activity 10.1: The Carina Nebula bibliography

Note: A globule is a concentration of dust

This extract was adapted from the original article  published on Futurity, which you can

read here.
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Note:
An H II region is a gas cloud containing a large amount of ionized hydrogen (H II) - hence the name.
Massive stars form in these regions.

Interstellar extinction is the dimming of light from stars due to absorption by the surrounding dust.

An OB association is a type of stellar association (or star cluster) formed by stars of spectral type O
and B (they are the most luminous and hottest).

This extract was adapted from the original paper which you can read here.
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Note:
An H II region is a gas cloud containing a large amount of ionized hydrogen (H II) - hence the name.
Massive stars form in these regions.

This extract was adapted from the original paper which you can read here.
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This extract was adapted from the original paper which you can read here.
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Write down everything you know about the Carina Nebula:

Activity 10.2: The Trumpler 14 region

Having read through the extracts above,

you have probably noticed a specific

region being mentioned several times,

and that is Trumpler 14 (Tr 14). It is one of

the youngest known star clusters and is

known to be an active region of star

formation within the Carina Nebula. The

coordinates for Trumpler 14 are RA: 10h

43m 55.92s and DEC: -59º32’60.00’’.

Throughout this Scientific Challenge, we

will focus on finding stars in the process

of formation within this famous cluster.

Figure 90: Trumpler 14.

(Credit:https://hubblesite.org/image/3693/news)
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Activity 11: Inspecting star formation regions

PHASE 1 of star formation involves molecular clouds, also called star nurseries. Here you

will get a chance to explore different clouds, enjoy!

Activity 11.1: Get familiar with clouds on ESASky

PROCEDURE IN INSTRUCTIONS:

1. Click on this link to enter ESASky: https://sky.esa.int

2. Select the explorer mode

3. Click on the parchment icon.

4. Click on the target list.

5. Select the bright nebulae or dark nebulae from the list

6. Click around on any nebula you want, a spectacular image of each one you click will

appear

7. Each object includes some extra information. Take some time to explore around!
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PROCEDURE IN IMAGES:

2. 3.

4. 5.

6.

7.
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Activity 11.2: Classification of nebulae

Since reflection and emission nebulae are usually observed together, we are going to treat them as

one single category;  bright nebulae.

Can you tell whether the following nebulae are bright or dark? Write a B or a D next to each one.

a) b)

c) d)

Figure 91: Various nebulae from ESASky (Credit: ESASky)

Try to recognize the nebulae on Figure 91 in the list of bright and dark nebulae created on

ESASky and annotate their names and coordinates in Table 6. Write down the RA, DEC

central coordinates for each nebula. Look for the nebulae on ESASky and write down the

name of each cloud. Review Activity 2.1 to refresh the concepts of RA and DEC if you

need to.
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Name of the nebula Central coordinates

Table 6: ESASky nebulae

Remember you can always access ESASky and look for a region in the sky in the

search box on the right hand side, searching for their coordinates or technical name

(on the AladinLite database).

Note: Write on google the name of your object and AladinLite will show you the result
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Activity 11.3: Calculating sizes of non-circular objects

The sizes of these nebulae are given below. Since these regions are not circular, the sizes

are given as a height and width.

Barnard 68 (500 ly away) Horsehead nebula (1500 ly away)

Carina (7500 ly away) Orion (1334 ly away)
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1. Each team picks a nebula.

Options:

- Barnard 68

- Horsehead nebula

- Carina

- Orion

2. Given the angular diameters and the distances to these, calculate their sizes in

kilometers.

3. Instead of kilometers, what units would be more appropriate for these sizes?

For Barnard 68:

For Horsehead nebula:

For Carina:

For Orion:
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Activity 11.4: Downloading astronomical images from ESASky

Activity 11.4.1: Download SAOImage DS9

1. Access the following link to download SAOImage DS9 depending on your

computer:

- MacOSX: link

- Windows: link

- Linux: link

Having inspected the above nebulae, we are now going to focus on the Carina Nebula,

more specifically in Trumpler 14. To do this we will use Herschel images from ESASky of

this region and the astronomical program SAOImage DS9,  an astronomical imaging and

data visualization tool. Here are the steps to do so:

PROCEDURE IN INSTRUCTIONS:

1. Click on this link to enter ESASky: https://sky.esa.int

and select the science mode.

2. On the right-hand corner you will see a search bar. Introduce the name of “Trumpler

14” or the central coordinates.

3. Zoom out clicking the - sign 3 times.

4. Click the “available images” icon, on the upper-left hand side, which resembles a

galaxy, which says “examine the images in this region”.

5. Select the “Herschel (far infrared to submillimeter)” block.
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6. You should get regions drawn in the background with the names of the observations

in the catalogue. The size of the square indicates the number of images available for

that region in said catalogue.

7. Select the observation with the “ObsId:1342211615” and the “Target Name: Carina

Nebula Complex-1” with the instrument “PACS”.

8. Visualize said image by clicking on the magnifying glass symbol

9. Download the image by clicking on the left-hand side button (a downwards pointing

arrow)

10.You should obtain a compressed file (with .tar format)  in your downloads folder.

11.Open this file and you will get a folder. Open this folder to see the two documents

inside it.

12.

a. If you have a Windows computer, you may open these types of compressed

files with a program called 7ZIP. This will decompress the tar files into fits.gz

and from fits.gz to fits.

b. If you have a Mac or Linux computer, click on the tar file and it will

decompress automatically into fits.gz files. By double clicking on these, you

will obtain the fits format required.

The names of the files to visualize on SAOImage DS9 are:

- hpacs_25HPPJSMAPB_blue_1043_m5925_00_v1.0_1471643665627.fits

- hpacs_25HPPJSMAPR_1043_m5925_00_v1.0_1471643689343.fits

13.For simplicity, rename the files in order to find them easily later on:

- Trumpler14_blue.fits

- Trumpler14_red.fits

14.Open the SAOImage DS9 program to visualize your images. To do so, on the main

menu, follow the following steps:

File →  Open as →  Mosaic Segment WCS → (name of your file)

Trumpler14_blue.fits
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15.Select the following parameters for a better visualization of the image:

- “Zoom” = “Fit”

- “colour” = “bb”

- “scale” = “sqrt” & “zscale”

16.You can define the parameters more in detail on the visualization scale in the

following way:

“Scale” →  “Scale parameters”

Adjust the parameters:

low = 0

max = 10

and click on “Apply”

17.Repeat this for the file named Trumpler14_red.fits
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PROCEDURE IN IMAGES:

1. 2.

3. 4.

5. 6.
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7. 8.

9. 10.

11. 12.

13.
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14.

15.
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16.

The image you will obtain is a Herschel, far infrared image (micrometers) showing the

density of clouds in Trumpler 14.

1. Can you identify the region where the material is the most dense?
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Activity 11.5: RGB Images

Now that you are more familiar with working with astronomical images, you can go a step

further.

You have probably seen spectacular colourful images of objects in space but these

colours are usually “not real”, but rather enhanced for visualization purposes..

Astronomical images are taken with telescope detectors such as CCDs (Charged Couple

Device) and appear in black and white. However, when the CCD is used together with a

colour filter,  the image obtained enhances that specific colour, like in Figure 92.

Figure 92: Red band image of Carina Nebula from the

Digitized Sky Survey

By combining the same image, taken in

different filter bands, one can obtain a

coloured image. The combined image

receives the name of RGB Image, from the

combination of red, blue and green.

The RGB model correlates very well to how

humans perceive colour through the

receptors in our eyes, which are sensitive

to red, green and blue wavelengths.

Figure 93 shows the image taken for the three bands, which combined together form an

image with colour close to the “true colour” we would perceive is produced, Figure 94.

Figure 93: Red, green and blue band images of Carina Nebula from the Digitized Sky Survey
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Figure 94: RGB Image of Carina Nebula

Follow the procedure in steps and images.

PROCEDURE IN INSTRUCTIONS:

Download the three files from this link named “dss-verywide-r.fits”, “dss-verywide-g.fits”

and “dss-verywide-b.fits”.

1. Open SAOImage DS9.

2. Click on “Frame” → “New Frame RGB”.

3. A window called RGB will open, select the “Red” entry.

4. Click on “File” →  “Open as” → “Mosaic WCS Segment”.

5. Upload the “dss-verywide-r.fits” by selecting it and clicking “Open”.

6. Click “Ok”.

7. You should an image like on step 7 on the image procedure below.

8. Click on “Zoom” →  “Zoom fit” to obtain the whole image.

9. Next select “Frame” → “RGB” → “Green”.

10. Repeat Steps 5 and 6, loading the file called “dss-verywide-g.fits” file and you will

obtain an image of the red and green images on top of each other.

11. Select “Frame” → “RGB” → “Blue”.

12. Repeat Step 11 and upload the file called “dss-verywide-b.fits”.
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PROCEDURE IN IMAGES:

1. 2.

3. 4.
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5. 6.

7. 8.

9. 10.
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11. 12.

1. Once you have obtained the RGB Image, from the coordinates for Trumpler 14,

draw a circle where you think it is located… To help you with this, you can plot a

coordinate grid by clicking on “Analysis” and “Coordinate Grid”

2. To check your results, plot a circle showing Trumpler 14 following these steps:

1. Download the file called “Trumpler14.reg” onto your computer.

2. Back in SAOImage DS9, click “Region” →  “Load regions” and select the

region for Trumpler 14 you have just downloaded and click “open”

Did you get Trumpler 14’s location correct?
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Activity 11.6: Inspection with DS9

Now that we have identified Trumpler 14, let's take a look at a few sources in that region.

PROCEDURE IN INSTRUCTIONS:

1. Download the file “XMM2.vot” onto your computer. This is an example of a

catalogue, which we will work with in Activity 12.

2. On DS9 click “Frame” →  “New Frame”.

3. We are now going to upload an image directly from SAOImage DS9 by clicking

“Analysis” →  “Image Servers” →  “ESO-DSS I/II” or “DSS(ESO)” (depending on the

version you have installed)

4. In the pop-up window write “Trumpler 14” for the Object entry and click “Retrieve”.

5. Click “Zoom” → “Zoom Fit”.

6. You will have probably obtained a black and white image. You can change the

colour by clicking “colour”  →  “bb”.

7. Go onto “Analysis” →  “Catalog Tool”, you will get a new pop-up window.

8. At the very top click “File” →  “Load”.

9. Select the file “XMM2.vot” you have downloaded and click “open”. The file is a

catalogue containing 20 sources, whose positions are shown as green circles.
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PROCEDURE IN IMAGES:

1. 2.

3. 4.

5. 6.
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7. 8.

9.
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Answer the following questions:

1. Can you identify the source that is best centred? Write down the coordinates of this

source. You can read off the RA and DEC in the fk5 entry displayed on the screen

on SAOImage DS9.

2. The coordinates are in hh:mm:ss and degrees, arc minutes, arcseconds. Convert

these into degrees. Review Activity 2.1 to remind yourself on how to do this:

3. Once you know the position of source X, the next information we want is it’s

catalogue name. To find this, follow the procedure instructions and images:
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PROCEDURE IN INSTRUCTIONS:

1. Open the “Catalog tool” on SAOIMage DS9, which you obtained when you

uploaded the “XMM2.vot” catalogue.

2. Click on “Symbol” →  “advanced”.

3. In the “Text” entry, write the name of the column containing the sources’ names:

$iauname (this is the name of the source given by the IAU, International

Astronomical Union).

4. You should now see the names plotted over your sources. Zoom in onto the

well-centred source you found and write down its name next to the coordinates you

found.

PROCEDURE IN IMAGES:

1.

3.

2.

4.
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Name of the source:

Activity 12: Handling catalogues

We will now download astronomical catalogues from ESASky, to look for classical T Tauri

stars. These catalogues are: XMM-Newton, 2MASS and GAIA. We will also use VST data

from the ESO Archive.

Activity 12.1: Downloading catalogues from ESASky

Follow these steps to download the 2MASS catalogue:

PROCEDURE IN INSTRUCTIONS:

1. Click on this link to enter ESASky: https://sky.esa.int

2. Select the science mode

3. On the right-hand corner you will see a search bar

4. Introduce the name  “Trumpler 14” as shown in the Step 4 of “Procedure in

Images”

5. Zoom out by clicking on the ‘-’ symbol 5 times

6. Once Trumpler 14 is located, move your mouse to the left-hand side of the screen

and click the filters icon

7. Select the “Optical” option and “DSS2 colour” filter

8. You should now see an optical image of the Carina Nebula with the cross

indicating the position of Trumpler 14. (Note: If you move the image around, the

cross will be displaced too and you will have to conduct the search again)

9. Zoom in again by clicking the ‘+’ sign 2 times

10. The next step is to explore the catalogue data available for this region by

clicking on the icon for catalogues, shaped as an ellipse. You should then get all the

available catalogues displayed

11. Click the 2MASS square
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12. An empty tab should open and the background will be displayed as a grid of

yellow lines

13.  Click on the square with the cross in it, and click “load data”

14. The data you have just loaded will appear in a new tab and the position of the

sources are shown on the image.

15. Drag the tabs down, for better visibility of the image

16. Select the grid on the left of the one you have just selected. Once again click on

“load data”. A new tab will appear.

17. You should now have both squares containing the sources found by 2MASS and

two extra tabs with the corresponding catalogues. You should have 918 rows  in the

first catalogue and 706 in the second one. Each row corresponds to a source.  You

can check this on the bottom, right-hand corner

18. Click on the first catalogue, select all the sources by ticking the first column, as

shown in image 18

19. Click on the download icon

20. Click on VOTable, the catalogue will start downloading onto your computer. Do

not close ESASky

21. Repeat steps 18-20 with the second catalogue

22. Repeat step 13-20 for the two upper and lower squares

23. On your downloads folder you will get all the files

24. Rename the files, give them significant names such as “2MASS1”, “2MASS2”,

etc. and make sure to check the ending of the file from “.vot” to “.fits”. You are now

ready to work with the 2MASS catalogues on TopCat.

25. Downloading the XMM catalogue is very similar. From where you left ESASky,

click again on the catalogues icon to get the available catalogues displayed.

26. Select the 4XMM-DR10 catalogue.

27. Again, you will get the sources detected by XMM shown in purple squares this

time. Click on the downloading button again and download the table as a VOTable.

Once the file is downloaded onto your computer, rename it as “XMM” and change

the ending to .fits so that your file is called “XMM.fits”.
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PROCEDURE IN IMAGES:

2.

4.

6.

3.

5.

7.
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8.

10.

12.

9.

11.

13.
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14.

17.

19.

16.

18.

20.
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22.

24.
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25.

26.

27.
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Activity 12.2: Handling catalogues in TopCat

Use the result obtained in Activity 12.1. If you have not completed this Activity, use the file

in the link.

Activity 12.2.1: Download TopCat

1. Access the TopCat web: star.bris.ac.uk/~mb/topcat

2. Chose the “Standalone-Full.tar” version and download it onto your computer

TopCat is a program used to analyse and manipulate catalogues and is used in astronomy

due to its power in handling very large datasets

Activity 12.2.2: Concatenating tables

We have downloaded six 2MASS tables, which we want to later treat as a single

catalogue. In TopCat you can concatenate tables together. Follow these steps to

concatenate your 2MASS catalogues:

PROCEDURE IN INSTRUCTIONS:

1. Launch TopCat

2. Click on the folder symbol and then on “System Browser”. Select all the files and

click on “Open”.

3. Once you have the catalogues on TopCat click on “Joins” → “Concatenate Tables”

4. For the “Base Table” select the first catalogue “2MASS1.fits” and for the “Appended

Table” use the second catalogue, “2MASS2.fits”

5. Click on “Concatenate”. The joint table will save onto TopCat under the name

“concat(1+2)”

6. Repeat the concatenation between the new table “concat(1+2)” and the third

2MASS catalogue, “2MASS3.fits”.

7. Repeat this process, always concatenating the last table you produce with the next

2MASS catalogue. You will finally get a final catalogue with 4420 sources.

8. Save the final catalogue as “2MASStotal.fits”
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PROCEDURE IN IMAGES:

1. 2.

3. 4.
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5. 6.

7.

8.

116



Activity 12.3: Selecting classical T Tauri stars in Trumpler 14

The first selection of our possible classical T Tauri stars will entail checking whether they

are in the main phase of accretion. As we know, these objects emit Halpha emission,

hence we will use the VST catalogue.

The VST catalogue for the Trumpler 14 region contains 30964 sources, but not all contain

magnitude values. Download the catalog named “VST_initial” from this link and open it on

Google Sheet. You will obtain a table with the objects and their data in columns.

Each object will contain the following information in the columns:

- IAUNAME: name assigned to the source by the international Astronomical Union

(IAU), using the vphas+coordinates nomenclature

- RA2000: Right ascension in units J2000

- DEC2000: Declination in units J2000

- UAPERMAG3: magnitude in u filter

- UAPERMAG3ERR: error in the magnitude measurement in u filter

- UCLASS: classification of the object, in terms of its morphology in the u band, see

classification on Table 7

- GAPERMAG3: magnitude in g filter

- GAPERMAG3ERR: error in the magnitude measurement in g filter

- GCLASS: classification of the object, in terms of its morphology in the g band, see

classification on Table 7

- RAPERMAG3: magnitude in r filter

- RAPERMAG3ERR: error in the magnitude measurement in r filter

- RCLASS: classification of the object, in terms of its morphology in the r band, see

classification on Table 7

- R2APERMAG3: magnitude in the second r filter
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- R2APERMAG3ERR: error in the magnitude measurement in second r filter

- R2CLASS: classification of the object, in terms of its morphology in the second r

band, see classification on Table 7

- IAPERMAG3: magnitude in i filter

- IAPERMAG3ERR: error in the magnitude measurement in i filter

- ICLASS: classification of the object, in terms of its morphology in the i band, see

classification on Table 7

- HAVPHASAPERMAG3: magnitude in Halpha filter

- HAVPHASAPERMAG33ERR: error in the magnitude measurement in Halpha filter

- HAVPHASCLASS: classification of the object, in terms of its morphology in the

Halpha band, see classification on Table 7

Every time a measurement is taken in science, it has a margin of error.

Table 7 shows the decoding of the VST catalog classes. The columns containing the

"classes" can have the following values. Depending on the value, the object in question is

probably a star, a galaxy or just noise

CLASS
VALUE

OBJECT CLASSIFIED
AS...

0 noise

1 galaxy

-1 star

-2 probably a star

-3 probably a galaxy

-9 saturated

Table 7: Classes in the VST catalog
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If you were to get a UCLASS = 0 for a source, then that means that source has been

classified by previous studies as being noise (i.e. not interesting for us).

As described in Activity 11.5, the measurements recorded on this catalogue are taken by

CCDs which are photon detectors. Each photon arriving at the CCD generates an electron

which is registered as an “event”. CCDs are divided into small squares (known as pixels),

sensitive to light. “UAVERAGECONF” or “GAVERAGECONF” describes the probability that

a pixel has detected incoming light correctly and the measurement can be trusted.

Activity 12.3.1: Selection criteria

For our first selection of classical T Tauri stars we will select the sources which meet these

requirements:

✔ Magnitudes r (RAPERMAG3) and r2 (R2APERMAG3) (magnitudes with both r filters)

> 13.0 mag. This way we prevent any excessively bright objects from saturating the

detector.

✔ the error < 0.1 mag in bands g (GAPERMAG3ERR), r (RAPERMAG3ERR), r2

(R2APERMAG3ERR), i (IAPERMAG3ERR) and Halpha (HAVPHASAPERMAG3ERR)

✔ classified as como stars in bands g and i (GCLASS = ICLASS = -1)

✔ classified as stars or probably stars in bands r and r2 (RCLASS and R2CLASS with

values -1 or -2)

✔ classified as stars, probably stars or galaxies in bands Halpha and u

(HAVPHASCLASS and UCLASS equal to values 1, -1 or -2)

✔ pixel confidence > 90.0 in u, g, r, r2, i (UAVERAGECONF, GAVERAGECONF,

RAVERAGECONF, R2AVERAGECONF, iAVERAGECONF > 90.0%)

✔ pixel confidence > 95.0 in band Halpha (HAVPHASAVERAGECONF > 95.0%)
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Activity 12.3.1.1: Using Google Sheets

(Link to video tutorial)

Copy the VST catalogue into Google Sheets. Go through each of the columns in the list

above and filter out the sources that do not meet the criteria stated. To do so, follow the

procedure in instructions or images.

PROCEDURE IN INSTRUCTIONS:

1. Open the “VST_initial.csv” file in Google Sheet

2. Select the first row containing the names of each column

3. Click on the menu on “View” → “Freeze” → “1 row”

4. Search the column “RAPERMAG3· and select it completely by right clicking on the

letter assigned to that column, in this case it should be the letter Q

5. Select the option “Sort sheet A → Z”. This will sort the column in ascending order.

You will see many of the values are below 13.0. These are the ones we will be

getting rid of

6. Click on the upper left corner of the table to select it completely. The whole table

will be highlighted

7. Click on the filtering icon. The table will appear green and a filtering symbol will

appear next to each column’s name

8. To do the filtering, click on this symbol for the specific column you are interested in.

For instance, let's filter the column “R2APERMAG3”. We want values to be above

13.0

8.1. Click on the filtering symbol for column “R2APERMAG3”

8.2. In the drop-down menu select the option “Filter by condition”

8.3. Select the option “Greater than” → write 13.0 → click on “OK”

8.4. Repeat steps 8.1 to 8.3 for the rest of the selection criteria, taking into

account whether the criteria requires the “Greater than” or “Less than” option
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8.5. For the criteria on “classes” seen on Table 8, click on the filtering symbol of a

column

8.5.1. Select the option “Filter by values”

8.5.2. Select only those values you wish to maintain
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8.3. 8.5.1
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Activity 12.3.1.2: Using Excel

(Link to video tutorial)

PROCEDURE IN INSTRUCTIONS:

1. Download the VST_initial file onto your computer

2. Open the file in Excel by clicking on Open → selecting your file → open. You will

obtain the complete table

3. Select the first row with the names of the columns

4. Click on “View” → ”Freeze Top Row”

5. Select the entire “R2APERMAG3” column and click on the filter symbol called “Sort

& Filter“ → “Sort Smallest to Largest” → “Sort”

6. Select the entire table by clicking on the upper-left hand side corner

7. Again click on the filter symbol → “Filter”. Each column will have now have an

downwards arrow on its side

7.1. Click on the arrow of the “R2APERMAG” column

7.2. Choose the option “Greater than” and write on the side 13,0. Then click on

“Apply filter” and close the pop-up window

7.3. Repeat this filtering for the rest of the properties taking into account whether

the criteria requires the “Greater than” or “Less than” option

8. For the criteria on “classes” seen on Table 8, click on the filtering symbol of a

column

8.1. Select only those values you wish to maintain on the list displayed in the

pop-up window

124

https://drive.google.com/drive/folders/1lTayPxKD4iWOiJMCnuBGqzPrmTKUu25F


PROCEDURE IN IMAGES:

2. 3.

4. 5.

6. 7.
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7.1 7.2

8.1
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Once you have filtered your sources, how many do you have remaining?

Save the file containing the sources which meet the selection criteria naming it

candidates_final.

Activity 12.4: Construct colour-colour diagrams

Review Activity 2.5.3 to remind yourself about colour-colour diagrams.

We will be constructing a colour-colour diagram to plot the candidates which met the

selection criteria in Activity 12.3.1. These are our candidates to TTauri stars for now.

To do so, follow the procedure on your Google Sheet final table you named

“candidates_final” in Activity 12.3.1.

Activity 12.4.1: Using Google Sheets

(Link to video tutorial)

PROCEDURE IN INSTRUCTIONS:

1. Open the table named “candidates_final”, select it, and copy and paste it entirely

onto a new Google Sheets

2. Add two columns at the end of the table

3. Name these “R-I” and “R-Halpha” respectively

4. On the first empty row of column “R-I” write the expression =(AX-BY) where:

- A = letter defining the column “RAPERMAG3”

- X = number of the first empty row in column “R-I” (should be number

2)

- B = letter defining the column “IAPERMAG3”
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- Y = number of the first empty row (should be 2 again)

- It will then ask you whether you want to apply this expression for the

rest of the column, click on accept

This is how the magnitude value from band i is subtracted from band r resulting in the (r-i)

colour.

5. Repeat step 4 with the column “R-Halpha” to obtain the (r-Halpha) colour with the

corresponding columns

6. Select both column you have created “R-I” and “R-Halpha”

7. Click on the plotting icon

8. In “format” select “Scatter plot” option

9. For the X axis, select the colour (r-i)

10. In the “Series” option, click on the three dots to the right of “R-I” and click on

“Remove”. This set the Y axis to be the (r-Halpha) colour

11.Add the axes titles as well as the plot title by clicking on the plot menu on

“Customize” → “Chart & Axis title” → fill in the “Title text” with the plot title →

Instead of “Chart title” select “Horizontal axis title” and write R-I. Repeat this for the

Y axis (vertical)

12.Click on “Series” → “Point size” and select the 2px option

13.You should obtain a colour colour diagram like on step 13 of the procedure in

images
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2. 3.

4.
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Activity 12.4.2: Using Excel

(Link to video tutorial)

PROCEDURE IN INSTRUCTIONS:

1. Open the table named “candidates_final”, select it, and copy and paste it entirely

onto a new Excel sheet

2. Select the first row with the names of the columns

3. Click on “View” → “Freeze Top Row”

4. Add two columns at the end of the table

5. Name these “R-I” and “R-Halpha” respectively

6. On the first empty row of column “R-I” write the expression =(AX-BY) where:

- A = letter defining the column “RAPERMAG3”

- X = number of the first empty row in column “R-I” (should be number

2)

- B = letter defining the column “IAPERMAG3”

- Y = number of the first empty row (should be 2 again)

- Click on the lower-right hand side corner of the box. This will apply the

equation to the entire column

This is how the magnitude value from band i is subtracted from band r resulting in the (r-i)

colour.

7. Repeat step 4 with the column “R-Halpha” to obtain the (r-Halpha) colour with the

corresponding columns

8. Select both columns you have created “R-I” and “R-Halpha”

9. Click on “Insert” and on the scatter plot option select the first option

10. Double click on the title to change it

11. For the x and y axis titles click on “Add chart element” → “Axis titles” → “Primary

horizontal” or “Primary vertical” and add the desired name
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12.You should obtain a colour-colour diagram like the one shown in step 11 in the

procedure in images
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1. Check whether you get a plot like that on step 13 of the procedure with Google

Sheets or 10 with Excel

2. Select the 4 sources you think have the strongest Halpha emission (Note:

remember, the stronger the emission in a band, the lower its magnitude)

3. When you have selected these 4 sources, complete Table 8 with their coordinates

(RA, DEC) and colour (r-Halpha). You can read this information from the Google

Sheet table

(RA, DEC) colour (r - Halpha)

Table 8: Four sources with strongest Halpha emission
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Activity 12.5: Identifying sources on the VST catalogue with SAOImage

1. Download the image “CarinaHalpha” onto your computer from from this link. This

image is compressed

2. In order to be able to work with this image we must decompress it twice

- If you have a Windows computer, you may make use of programs

such as “72ZIP” to decompress the image

- If you have a Mac computer, you can decompress the file by double

clicking on it twice until you obtain a file with the .fits extension

3. On SAOImage DS9 click on “Frame” → “New frame”

4. Upload the Carina image. This image was taken by VST with a Halpha filter

5. On the menu click on “Zoom” and select the “Align” option to align the image

6. The color of the image should be black and white (option “greyscale”). You can

change this by going onto “Scale” →  “Scale parameters” and set the upper limit

(“High”) to 1910 and “Apply”

7. Again click on “Analysis” →  “Catalog tool” and load the “candidates_final.VOT” (link

to the file) catalogue with all your sources
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8. Make sure you select RA2000 and Dec2000 for the entries and . Ignore anyα δ

possible error message you might get. This will plot the regions of the sources you

filtered out onto the image.

9. Once the regions are plotted, click on “Analysis” →  “Coordinate Grid”. This will help

you find the sources. Hovering over the sources will show you a zoomed-up image

on the far right of the ds9 interface

Your task now is to identify the 4 sources you found to have the highest Halpha emission

on this image. To do this, you should convert their coordinates from degrees to hours,

minutes, seconds and degrees, arcminutes, arcseconds for RA and DEC respectively. Here

is how to do that:
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How to convert right ascension (RA) from

degrees to (hh,mm,ss)

How to convert declination DEC from degrees to

(degrees, arcminutes, arcseconds)

1. To divide the right ascension coordinate

from degrees to hours, you can divide the

number of degrees by 15 (Note: this is

because 360 degrees are 24 hours)

2. You will obtain a decimal number of hours

2.1. The whole number will be the hours

2.2. The decimal part can be converted

into minutes by multiplying by 60

(Note: 1 hour is 60 minutes)

2.3. The decimal part of the minutes you

obtain can be converted into

seconds by multiplying by 60 (Note:

1 minute is 60 seconds)

Example:

161.85776º

→ 10 h161.85776
15 =  10. 7905173

→ 47 min0. 7905173 × 60 = 47. 43104

→ 25.8s0. 43104 × 60 =  275. 8624

161.85776º = 10h 47m 25.8 s

1. Obtain a decimal number in degrees

1.1. The whole number gives you the

degrees

1.2. The decimal part of the number in

degrees can be converted into

arcminutes by multiplying by 60

(Note: 1 degree is 60 arc minutes)

1.3. The decimal part of the arc minutes

can be converted into arcseconds

by multiplying by 60 (Note: 1 arc

minute is 60 arc seconds)

Example:

-59.52057º

-59º

→ 31 arcmin0. 52057 × 60 =  31. 2342

→ 14.052 arcsec0. 2342 × 60 =  14. 052 

Fill in Table 9 with the necessary information on the 4 sources you found to have the

strongest Halpha emission.
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Sources Colour (r - Halpha) RA (degrees) DEC (degrees) RA (hh, mm,
ss)

DEC (º, ’, ”)

A

B

C

D

Tabla 9: Información on the four sources with strongest Halpha emission
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Activity 12.6: Fine-tuning the selection of classical T Tauri stars

Activity 12.6 is divided into three parts.

Activity 12.6.1: Part 1

We have conducted the first selection of possible classical T Tauri stars based on their

magnitudes on the VST catalogue and have identified four of them on a Halpha image.

The next step to fine-tune our selection of prostars in the process of accretion is to look for

a specific amount of Halpha emission. To do this we will use the colour-colour diagram you

plotted on Activity 12.4. Sources with larger (r-Halpha) colour will have stronger Halpha

emission (remember, a smaller magnitude means brighter object in that band).

The colour of stars follows a specific function, called the “reddening curve” or “extinction

curve”.

Light extinction refers to the absorption of electromagnetic radiation coming from

astronomical objects. The interstellar gas and dust between the object and the observer

absorbs some of the light. In the visible, blue light is more affected by extinction than red

light, resulting in objects appearing redder than normal. This is why this effect is also

known as "interstellar reddening".

The extinction or reddening curve defines the limit to the (r-Halpha) colour of our classical

T Tauri stars. Add this curve onto your colour colour diagram by using the data on the

“reddening-curve” file. To do so follow the procedure:
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Activity 12.6.1.1: Using Google Sheets

(Link to the video tutorial)

PROCEDURE IN INSTRUCTIONS:

1. Open the file “reddening curve” on Google Sheets

2. Copy the column named r-i and paste it onto the end of your R-I column of the

“candidates_final” table, leaving an empty row in between

3. Select the r-Halpha column on the “reddening curve” file and copy it onto a new

column, to the right of your R-Halpha column on the “candidates_final” table. Name

this new column “curve”

4. Select the three columns “R-I”, “R-Halpha” and “curve”

5. Click on the plotting icon

6. Select the “Scatter plot” option

7. For the X axis select “R-I”

8. For the Y axis delete the series “R-I”

9. Custom the data points by click on “Customize” → “Series” → select R-Halpha →

“Point Size”: 2px → change R-Halpha for Data series 2 → “Point Shape”: square

10.You should obtain a diagram like that on step 10 of the procedure in images
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PROCEDURE IN IMAGES:

1. 2.

3. 4.
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5. 6.

7. 8.
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Activity 12.6.1.2: Using Excel

(Link to the video tutorial)

PROCEDURE IN INSTRUCTIONS:

1. Download the “reddening_curve” file onto your computer and open with Excel

2. Copy the column named r-i and paste it onto the end of your R-I column of the

“candidates_final” table, leaving an empty row in between

3. Select the r-Halpha column on the “reddening curve” file and copy it onto a new

column, to the right of your R-Halpha column on the “candidates_final” table. Name

this new column “curve”

4. Select the R-I and R-Halpha data of the sources (i.e. not the reddening curve data

you have just added)

5. Click on “Insert” → and on the scatter plot option select the first option. You should

obtain the r-Halpha versus r-i colour colour diagram

6. Click on “Select data”

7. On the pop-up window click on the “+” sign to add a new data series to your plot

7.1. Click on the “x values” entry, then on your table click on the first r-i data box

you have added from the reddening curve file and drag downwards to select

the rest

7.2. Go back to the pop-up window and click on “y values”. Then for the y values

select in the same way the data on your column called curve

7.3. Click on “OK”

8. You should obtain the colour colour diagram with the reddening curve

9. To change the labels of the legend click again on “Select data”

9.1. Select “Series1” and on the space write “Data points”

9.2. Do the same for “Series2” and name it “curve”

10. You should obtain a diagram like on step 10 of the procedure in images

146

https://drive.google.com/drive/folders/1sVEMwB3hbpWmvZwbAZJY9w31lW21zEM_
https://docs.google.com/spreadsheets/d/1BFqISlpGGfe1IvM8UBW05mJz0iF-XB_y/edit#gid=1845735393


PROCEDURE IN IMAGES:
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The reddening curve defines a boundary for the (r-Halpha) colour of classical T Tauri stars.

Any (r-Halpha) colour higher than this curve is called (r-Halpha) excess and is defined as:

( (Equation 10)𝑟 − 𝐻α)
𝑒𝑥𝑐𝑒𝑠𝑠

= (𝑟 − 𝐻α)
𝑜𝑏𝑠𝑒𝑟𝑣𝑒𝑑

− (𝑟 − 𝐻α)
𝑚𝑜𝑑𝑒𝑙

 

where the (r-Halpha) colour observed is the measurements you have plotted on the

colour-colour diagram (in blue dots)  and the (r-Halpha) colour of the model is that

expected from the curve (in red squares).

Activity 12.6.2: Part 2

1. Can you calculate the (r-Halpha) colour excess for the source with the highest

emission in Halpha?

1.1. What is the (r-Halpha) observed colour?

1.2. What is the (r-Halpha) for the model?

1.3. Subtract the model value from the observed value
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Activity 12.6.2.1: Using Google Sheets

(Link to the video tutorial)

2. Calculate the excess for every source with a colour above the reddening curve. Hint:

first filter out these sources

2.1. If you look at the colour colour diagram you obtained, you will notice sources

with (r-i) colour between 0.0 and 0.2 should have a (r-Halpha) colour > 0.1 in

order to be positioned above the curve. We will using such conditions to

select sources

2.2. Open the “candidates_final.xls” table on Google Sheet

2.3. Click on “Filter”

2.4. The minimum point on the reddening curve has the following coordinates:

(0.26, 0.069) meaning any sources with (r-Halpha) < 0.069 can be deleted. To

do so click on the filtering symbol of the (R-Halpha) column and click on

“Filter by condition” →  “Greater than” and write 0.069

2.5. Right click on the (R-I) column and click on “Sort column A → Z”

2.6. For 0 < r-i < 0.2 select each row with r-Halpha<0.1,  there should be 10 such

rows and delete them by clicking on” Edit” → “delete selected rows”

2.7. For 0.2 < r-i < 0.3 delete sources with r-Halpha <0.095 (6 sources)

2.8. For 0.3 < r-i < 0.4 delete sources with r-Halpha <0.13, (8 sources)

2.9. For 0.4 < r-i < 0.5 delete sources with r-Halpha <0.19, (10 sources)

2.10. For 0.5 < r-i < 0.6 delete sources with r-Halpha <0.25, (8 sources)

2.11. For 0.6 < r-i < 0.7 delete sources with r-Halpha <0.37, (17 sources)

2.12. For 0.7 < r-i < 0.8 delete sources with r-Halpha <0.4, (14 sources)

2.13. For 0.8 < r-i < 0.9 delete sources with r-Halpha <0.45, (11 sources)

2.14. For 0.9 < r-i < 2.0  delete sources with r-Halpha <0.62, (6 sources)

2.15. Copy this table onto a new Google Sheet. You should have 231 sources

remaining.
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2.16. Plot the colour colour diagram again with the remaining sources and the

reddening curve. Every source you be positioned above the curve

2.17. Save this table and name it “candidates_final_R-Halpha.xls”

You should get the following graph:

Figure 95)a): Colour colour diagram of sources with (r-Halpha) colour above the reddening curve obtained

with Google Sheets
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Activity 12.6.2.2: Using Excel

(Link to the video tutorial)

PROCEDURE IN INSTRUCTIONS:

1. Select the entire table by clicking on the upper-left hand side corner

2. If you look at the colour colour diagram you obtained before, you will notice sources

with (r-i) colour between 0.0 and 0.2 should have a (r-Halpha) colour > 0.1 in order

to be positioned above the curve. We will using such conditions to select sources

2.1. Click on “Sort & Filter” → “Filter”

2.2. The minimum point on the reddening curve has the following coordinates:

(0.26, 0.069) meaning any sources with (r-Halpha) < 0.069 can be deleted. To

do so select the (R-Halpha) column → click on the filtering arrow next to the

name → Choose “Greater than” → write 0,069 → “Apply filter” → close the

pop up window

2.3. Select the (R-I) column and click on “Sort & Filter” → “Sort smallest to

largest” → “Sort”

2.4. For 0 < r-i < 0.2 select each row with r-Halpha<0.1,  there should be 10 such

rows and delete them by clicking on the drop-down arrow on “Delete” →

“Delete Table Rows”

2.5. For 0.2 < r-i < 0.3 delete sources with r-Halpha <0.095 (6 sources)

2.6. For 0.3 < r-i < 0.4 delete sources with r-Halpha <0.13, (8 sources)

2.7. For 0.4 < r-i < 0.5 delete sources with r-Halpha <0.19, (10 sources)

2.8. For 0.5 < r-i < 0.6 delete sources with r-Halpha <0.25, (8 sources)

2.9. For 0.6 < r-i < 0.7 delete sources with r-Halpha <0.37, (17 sources)

2.10. For 0.7 < r-i < 0.8 delete sources with r-Halpha <0.4, (14 sources)

2.11. For 0.8 < r-i < 0.9 delete sources with r-Halpha <0.45, (11 sources)

2.12. For 0.9 < r-i < 2.0  delete sources with r-Halpha <0.62, (6 sources)
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2.13. Copy this table onto a new Excel Sheet. You should have 231 sources

remaining.

2.14. Plot the colour colour diagram again with the remaining sources and the

reddening curve. Every source you be positioned above the curve

2.15. Save this table and name it “candidates_final_R-Halpha.xls”

You should get the following graph:

Figure 95)b): Colour colour diagram of sources with (r-Halpha) colour above the reddening curve obtained

with Excel
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Activity 12.6.3: Part 3

Activity 12.6.3.1: Using Google Sheet

(Link to video tutorial)

1. Calculate the (r-Halpha) excess of sources taking into account their (r-i) colour. We

will do so by dividing the reddening curve into piecewise functions with equations

extracted from Figure 95:

rc1 = (r - Halpha) - 0.1

rc2 = (r - Halpha) - 0.095

rc3 = (r - Halpha) - 0.13

rc4 = (r - Halpha) - 0.19

rc5 = (r - Halpha) - 0.25

rc6 = (r - Halpha) - 0.37

rc7 = (r - Halpha) - 0.4

rc8 = (r - Halpha) - 0.45

rc9 = (r - Halpha) - 0.62

To do so, follow this procedure. (Note: when you see “ADX”, the X corresponds to

the number of the row. For example, AD2 is column AD, row 2)

2. Take the Google Sheet file “candidates_final_R-Halpha.xls”

2.1. We will focus on the (r-i) ranges and apply a criterion to each in new columns

2.2. Add a new column at the end for range 0<(r-i)<0.2

2.3. Write the rc1 function in box AF2. This function is (AD2-0.1).

2.4. Drag this expression for the entire range 0<(r-i)<0.2

2.5. Add a new column at the end for range 0.2<(r-i)<0.3

2.6. Write the rc2 function in box AGX. This function is (ADX-0.095)

2.7. Drag this expression for the entire range 0.2<(r-i)<0.3

2.8. Add a new column at the end for range 0.3 < (r-i) < 0.4

2.9. Write the rc3 function in box AHX. This function is (ADX-0.13)

2.10. Drag this expression for the entire range 0.3 < (r-i) < 0.4
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2.11. Add a new column at the end for range 0.4 < (r-i) < 0.5

2.12. Write the rc4 function in box AIX. This function is (ADX-0.19)

2.13. Drag this expression for the entire range 0.4 < (r-i) < 0.5

2.14. Add a new column at the end for range 0.5 < (r-i) < 0.6

2.15. Write the rc5 function in box AJX. This function is (ADX-0.25)

2.16. Drag this expression for the entire range 0.5 < (r-i) < 0.6

2.17. Add a new column at the end for range 0.6 < (r-i) < 0.7

2.18. Write the rc6 function in box AKX. This function is (ADX-0.37)

2.19. Drag this expression for the entire range 0.6 < (r-i) < 0.7

2.20. Add a new column at the end for range 0.7 < (r-i) < 0.8

2.21. Write the rc7 function in box ALX. This function is (ADX-0.4)

2.22. Drag this expression for the entire range 0.7 < (r-i) < 0.8

2.23. Add a new column at the end for range 0.8 < (r-i) < 0.9

2.24. Write the rc8 function in box AMX. This function is (ADX-0.45)

2.25. Drag this expression for the entire range 0.8 < (r-i) < 0.9

2.26. Add a new column at the end for range 0.9 < (r-i) < 2.0

2.27. Write the rc9 function in box ANX. This function is (ADX-0.62)

2.28. Drag this expression for the entire range 0.9 < (r-i) < 2.0

You should end up with a table similar to this one:

Figure 96: Table containing r-i colour to select candidates based on reddening curve
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Activity 12.6.3.2: Using Excel

(Link to video tutorial)

1. Calculate the (r-Halpha) excess of sources taking into account their (r-i) colour. We

will do so by dividing the reddening curve into piecewise functions with equations

extracted from Figure 95:

rc1 = (r - Halpha) - 0.1

rc2 = (r - Halpha) - 0.095

rc3 = (r - Halpha) - 0.13

rc4 = (r - Halpha) - 0.19

rc5 = (r - Halpha) - 0.25

rc6 = (r - Halpha) - 0.37

rc7 = (r - Halpha) - 0.4

rc8 = (r - Halpha) - 0.45

rc9 = (r - Halpha) - 0.62

To do so, follow this procedure. (Note: when you see “ADX”, the X corresponds to

the number of the row. For example, AD2 is column AD, row 2)

2. Take the Excel sheet “candidates_final_R-Halpha.xls”

2.1. We will focus on the (r-i) ranges and apply a criterion to each in new columns

2.2. Add a new column at the end for range 0<(r-i)<0.2 by selecting the first

empty column of the end of the tabla → “Insert” → “Insert Sheet Columns”

2.3. Write the rc1 function in box AF2. This function is (AD2-0.1).

2.4. Drag this expression for the entire range by clicking on the lower left hand

side corner of the box and dragging downwards for 0<(r-i)<0.2

2.5. Add a new column at the end for range 0.2<(r-i)<0.3

2.6. Write the rc2 function in box AGX. This function is (ADX-0.095)

2.7. Drag this expression for the entire range 0.2<(r-i)<0.3

2.8. Add a new column at the end for range 0.3 < (r-i) < 0.4

2.9. Write the rc3 function in box AHX. This function is (ADX-0.13)
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2.10. Drag this expression for the entire range 0.3 < (r-i) < 0.4

2.11. Add a new column at the end for range 0.4 < (r-i) < 0.5

2.12. Write the rc4 function in box AIX. This function is (ADX-0.19)

2.13. Drag this expression for the entire range 0.4 < (r-i) < 0.5

2.14. Add a new column at the end for range 0.5 < (r-i) < 0.6

2.15. Write the rc5 function in box AJX. This function is (ADX-0.25)

2.16. Drag this expression for the entire range 0.5 < (r-i) < 0.6

2.17. Add a new column at the end for range 0.6 < (r-i) < 0.7

2.18. Write the rc6 function in box AKX. This function is (ADX-0.37)

2.19. Drag this expression for the entire range 0.6 < (r-i) < 0.7

2.20. Add a new column at the end for range 0.7 < (r-i) < 0.8

2.21. Write the rc7 function in box ALX. This function is (ADX-0.4)

2.22. Drag this expression for the entire range 0.7 < (r-i) < 0.8

2.23. Add a new column at the end for range 0.8 < (r-i) < 0.9

2.24. Write the rc8 function in box AMX. This function is (ADX-0.45)

2.25. Drag this expression for the entire range 0.8 < (r-i) < 0.9

2.26. Add a new column at the end for range 0.9 < (r-i) < 2.0

2.27. Write the rc9 function in box ANX. This function is (ADX-0.62)

2.28. Drag this expression for the entire range 0.9 < (r-i) < 2.0

The resulting values are the (r-Halpha which we will now use to further tune the)
𝑒𝑥𝑐𝑒𝑠𝑠

selection of classical T Tauri stars.
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Activity 12.7: Fine tune the selection of classical TTauri stars with the Halpha Equivalent

width emission line

By using the excess (r-Halpha) colour measured previously, we can compute each

sources’ equivalent width. Review the concept of equivalent width in Activity 6.1.

Activity 12.7.1: Using Google Sheet

(Link to video tutorial)

1. Calculate the Halpha line equivalent width for the following (r-i) intervals. To do so,

follow this procedure:

1.1. Take the Google Sheet file "candidates_final_r-Halpha.xls" and copy the table

onto a new Google Sheet.

1.2. Add a new column between columns AF and AG (see Figure 98) and call it

EW

1.3. For values 0<(r-i)<0.2, in the new column AG', in row AG'2, write the following

expression (Note: in this case the Halpha filter had a width of

)107 𝐴𝑛𝑔𝑠𝑡𝑟𝑜𝑚 =  107 × 10−10𝑚

1.4. Drag this equation for 0<(r-i)<0.2

1.5. Add a new column between columns AH and AI

1.6. For 0.2<(r-i)<0.3, in the new column AI, in the row where your values start,

write the same equation. However, this time with AIX, where X is the number

of the row.

1.7. Repeat these steps with the next ranges in columns

1.8. Save the table as “candidates_final_r-Halpha_excess_EW.xls”

2. Once you have the file containing the equivalent widths, we are going to filter

sources again to identify classical TTauri stars. To do so follow this procedure:
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2.1. For 0 < (r-i) < 0.8 the candidates will have to have EW < -10 Angstrom.

2.2. For 0.8 < (r-i) < 0.9 the candidates will have to have EW < -12 Angstrom.

2.3. For 0.9 < (r-i) < 2.0 the candidates will have to have EW < -25 Angstrom.

2.4. Delete any rows which do not meet this criteria

2.5. You should end up with 95 sources remaining

2.6. Your colour-colour diagram should now only show those sources which

satisfy the EW boundary condition

2.7. Copy your data up until (and including)  r-Halpha column onto a new

spreadsheet

2.8. Download your file “candidates_final_r-Halpha_excess_EW” .csv format onto

your computer by clicking on “File” → “Download” → “CSV”
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Activity 12.7.2: Using Excel

(Link to video tutorial)

1. Calculate the Halpha line equivalent width for the following (r-i) intervals. To do so,

follow this procedure:

1.1. Take the Excel Sheet file "candidates_final_r-Halpha" and copy the table onto

a new sheet.

1.2. Add a new column between columns AF and AG by selection column AG →

“Insert” → “Insert sheet columns” and call it EW

1.3. For values 0<(r-i)<0.2, in the new column AG', in row AG'2, write the following

expression (Note: in this case the Halpha filter had a width of

)107 𝐴𝑛𝑔𝑠𝑡𝑟𝑜𝑚 =  107 × 10−10𝑚

1.4. Drag this equation for 0<(r-i)<0.2

1.5. Add a new column between columns AH and AI

1.6. For 0.2<(r-i)<0.3, in the new column AI, in the row where your values start,

write the same equation. However, this time with AIX, where X is the number

of the row.

1.7. Repeat these steps with the next ranges in columns

1.8. Save the table as “candidates_final_r-Halpha_excess_EW”

2. Once you have the file containing the equivalent widths, we are going to filter

sources again to identify classical TTauri stars. To do so follow this procedure:

2.1. For 0 < (r-i) < 0.8 the candidates will have to have EW < -10 Angstrom.

2.2. For 0.8 < (r-i) < 0.9 the candidates will have to have EW < -12 Angstrom.
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2.3. For 0.9 < (r-i) < 2.0 the candidates will have to have EW < -25 Angstrom.

2.4. Delete any rows which do not meet this criteria by selecting them and then

clicking on “Delete” → “Delete Table Rows”

2.5. You should end up with 95 sources remaining

2.6. As shown in Activity 12.6 Part 2, plot the colour colour diagram for the

remaining sources

2.7. Copy your data up until (and including)  r-Halpha column onto a new

spreadsheet and save as .CSV format
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The sources you have just selected are considered to be emitting Halpha strongly enough

to be accreting.

You should obtain the following graph:

Figure 97: Selection of TTauri candidates based on their equivalent width

Figure 98: Table on Google Sheets to filter candidates based on their equivalent width
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Activity 12.8: Compare the contributions from the optical, infrared and X-rays for

candidates to classical TTauri stars (data from VST, 2MASS and XMM-Newton) for the

Trumpler 14 region

Make use of the result obtained in Activity 12.7. If you have not completed this Activity,

make use of the file in this link.

Through Activity 12.3 to 12.7 we have filtered a catalog containing 30964 sources to one

containing 95 candidates, which meet the requirements of a CTTauri in terms of their

Halpha emission, a sign of accretion.

As mentioned in Activity 6, the identification of CTTauri stars requires an excess of infrared

(caused by the material in the accretion disk) and the emission of X-rays (caused by the

accretion process).

We therefore have to find out which and how many of these 95 candidates really are

CTTauri candidates. To do so we will be “matching” the catalog containing these Halpha

emitting candidates (VST catalog) with an infrared catalog (2MASS) and an X-ray one

(XMM-Newton). The match will check for similar coordinates (RA, DEC) shared between

the three catalogs with a margin of error.

This matching process will be conducted with a software used by astronomers called

TopCat. Follow the procedure in instructions or images:

PROCEDURE IN INSTRUCTIONS:

1. Retrieve the “candidates_final_r-Halpha_excess_EW” file in CSV format

2. Download TopCat onto your computer

2.1. Access the web and download the adequate option for your computer

(Topcat-full.jar)

165

https://drive.google.com/drive/folders/1jnEj8KwkNc-uQtnR5F0LJ9HJCiiPEobX


2.2. Double click on the downloaded file and TopCat will install onto your

computer. You are ready to proceed

3. Open TopCat

4. Load your “candidates_final_r-Halpha_excess_EW.csv” file you obtained in Activity

12.7. To do so on TopCat:

4.1. Go onto the main menu and click on “File” → “Load table”

4.2. Search for the CSV file on your computer and load it

5. Repeat step 3, selecting the “auto” format and load the “2MASStotal.fits” catalog

obtained in Activity 12.2.2 from the 6 regions on Trumpler 14 selected in ESASky

You should now have two catalogues available on TopCat as shown in the procedure in

images.

6. Click on the matching symbol and you will get a pop-up window

7. Select the catalogues you want to match, allowing an error between positions of 1.0

arcsec

7.1. Select  “candidates_final_r-Halpha_excess_EW.csv” as Table 1 and the

“2MASStotal.fits” catalog as Table 2

7.2. For the max error write down the value of 1.0 arcsec and click “Go”

You will obtain a new pop-up window specifying the number of matches found between

both catalogues. A third catalog containing the matches will automatically show on your

TopCat under the name “match(x,y)”

8. Click on “OK”

9. Select the matches catalog and click on the plotting icon. You will plot the (J-H) vs.

(H-Ks) colour colour diagram to find out how many sources show infrared excess.

10. In the pop-up window you will see SOURCEID has been selected by default as the

X axis and RA2000 for the Y axis. We will change this to obtain the colour colour

diagram
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10.1. Delete the SOURCEID on the X axis and instead write the expression

“h_m-ks_m”

10.2. Delete the RA2000 on the Y axis and instead write the expression “j_m-h_m”

11. Click on “Form” and reduce the size of the dots to 2

12. Next draw the boundary curve after which sources are considered to show IR

excess. This is done by selecting the line plotting symbol and writing down the

expression 1.86*x - 0.12, x being the independent variable. Click enter to obtain the

results

13. Save the plot to your computer by clicking on the “save” symbol

PROCEDURE IN IMAGES:

1. 3.
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4.1

5.

4.2
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6. 7.

8. 9.

10. 11.
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12. 13.

How many of the sources show infrared excess?
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Activity 12.8.1: Matching between the resulting catalog from VST & 2MASS with the

XMM-Newton for the Trumpler 14 region

Video tutorial: link

Use the result obtained in Activity 12.8. If you have not completed this Activity, make use

of the file in this link.

In Activity 12.8 we conducted the matching between catalogs offering information on

Halpha emission (VST) and on infrared excess (2MASS).

In this Activity we will fine tune our selection of classical T Tauri candidates selection only

sources which emit in X-rays.

PROCEDURE IN INSTRUCTIONS:

1. Load the “XMM.fits” file you obtained in Activity 12.1 from the XMM-Newton

sources in Trumpler 14, on ESASky

2. Download the “CCCP.fits” file. This catalog is from the Chandra Carina Complex

Project, carried out by Chandra, a NASA mission searching X-rays- The catalog

contains sources in the Carina Nebula which have been found to emit X-rays and

will add additional information onto your XMM catalog

3. Use TopCat to concatenate both catalogues (using the Joins option we saw in

Activity 12.2.2) “CCCP.fits” and “XMM.fits”. Make sure to select RA and DEC as

shown in image 3 on the procedure in images. Load both catalogs on TopCat using

the “auto” format. The result between the concatenation is saved as “concat(x+y)”

4. Repeat steps 4 to 7 of Activity 10.8 together with the resulting matched catalog

from said activity “match(a,b)” and the X-ray catalog “concat(x+y)”. This time use

2.0 arc seconds for the error between matches
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PROCEDURE IN IMAGES:

1. 2.
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3.

4.

The final number of objects is the list of candidates with Halpha emission, infrared and

X-ray. How many matches are there?

Plot the colour colour diagram again.

173



How many of the sources show infrared excess?

The next step is to check how many of these sources are at a reasonable distance to

belong to the Carina Nebula. This will indicate the final sample of possible classical T Tauri

stars.

To do so, the next and final step is to match our final catalog with GAIA.

Activity 13: Check whether your candidates are within the Carina Nebula (data from

GAIA)

The number of matches will tell you how many sources in Trumpler 14 are emitting in

Halpha, have an infrared counterpart and are also classified as X-ray sources. However,

for this last match, you will also have to check which of these sources show infrared

excess.

To do this, go onto ESASky and download the GAIA catalog for the Trumpler 14 region and

repeat the matching on TopCat as explained in previous Activities.

Follow the procedure in instructions and/or images.

PROCEDURE IN INSTRUCTIONS:

1. Repeat steps 1 to 10 of the procedure on Activity 12.1, only in this case you want

the GAIAeDR3(optical) catalogue. Download the same six regions as for 2MASS

and save in VOT format
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2. Repeat steps 1 to 3 of the procedure on Activity 12.2.2 and merge these catalogues

on TopCat. [You should have a final sample of 7646 GAIA sources].

3. Repeat steps 6 to 7 of the procedure on Activity 12.8 and do a match between the

candidates & 2MASS & XMMtotal catalogue with that of GAIA for a 1.0 arcsecond

error.

PROCEDURE IN IMAGES:

1. 2.
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3.

How many matches do you obtain?
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Plot the (J-H) vs (H-Ks) colour colour diagram with the limiting function (y = 1.86x - 0.12 to

identify how many of these sources display infrared excess.

Just from looking at the plot, how many do you see have infrared excess?

Now that we know how many of the sources show H emission, have infrared excess andα

are detected in the X-ray, we need to calculate the distance to these sources by using the

data provided by GAIA.

You will now calculate how far  these sources are from Earth to inspect whether they are

actually in Trumpler 14 (and in the Carina Nebula) or not.  In order to find out whether a

source is within a nebula, astronomers estimate the distance to each source via their

parallax and compare it to the estimated distance to the entire nebula. Those stars with a

similar distance as the one estimated for the cloud have a high chance of actually

belonging to it, and those that do not are probably just in the field of view.

GAIA provides such parallax measurements which you will now use.

Figure 99: Foreground stars in the field of view between the

observer on Earth and a molecular cloud.

Take a look at the final catalogue you have obtained and inspect the parallax (given in

milliarcseconds (mas)) of the 7 sources you have found to show infrared excess.

Tip: By selecting the different data points you will be able to obtain the corresponding row

on the catalogue.
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Out of the 7 sources, two may be disregarded due to their parallax. Can you identify these

two? Remember parallax is a measure for distance!

This means we are left with 5 sources of interest.

Write down the parallaxes of these 5 sources:

To calculate the distance to these sources, convert from milliarcseconds to pc.

Hint 1: Convert milliarcseconds to arcseconds

Hint 2:  Remind yourself of the definition of a parsec in Activity 2.2
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Stars in the Carina Nebula are expected to lie between 2200 pc and 2800 pc.

From your results, how many sources do you think are classical T Tauri stars within the

Carina Nebula?

Write down their source ID, RA, DEC, J mag, Ks mag, H mag, r mag, Halpha mag, i mag

and distance, and identify them on the (J-H) vs (H-K) and (r-H ) vs (r-i) colour-colourα

diagrams you plotted previously.

FEATURES

Table 10: Information on the final candidates
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Activity 14: Visualize the sources with SIMBAD/Aladin Lite

Now that you have identified your two potential classical T Tauri stars within Trumpler 14,

in the Carina Nebula, you can check whether these objects have already been identified

before in previous studies. To do this go onto SIMBAD, an astronomical database,

following this link:http://simbad.u-strasbg.fr/simbad/sim-fcoo.

Enter the coordinates of the sources without the comma separation and with a defined

radius of 2 arcseconds, as shown in Figure 100.

Figure 100: Search of Source 1 on SIMBAD
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Once you have searched your source, you can visualize it on the right-hand side (thanks to

AladinLite) , selecting the 2MASS option and zooming in with your mouse.

Figura 101: Visualización de fuentes en SIMBAD con la opción 2MASS.

SIMBAD will provide the following information about a source:

Figura 102: Information obtained on SIMBAD

as well as:

● the names assigned to a source under the section “Identifiers”

● the scientific publications on the source, under “References”

1. What information can you obtain about the final candidates? Fill in the spaces

below:
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Source 1
AladinLite image:

Name:
Classification:
Parallax:
Magnitude in R band:
R-I colour:

Source 2
AladinLite image:

Name:
Classification:
Parallax:
Magnitude in B band:
B-V colour:

2. Search for these sources on ESASky, obtain an image of them and paste it here.

Review how to use ESASky on Activity 11.1. Si te acuerdas:

2.1. Search the sources via their coordinates, without writing the coma

2.2. Change the filter on ESASky to “Near infrared”

Source 1: Source 2:

3. Name a study or publication conducted about these sources by writing down the

title of the publication and the date. To do so follow the procedure

PROCEDURE IN INSTRUCTIONS:

3.1. Once you have located your source, zoom in for better a view
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3.2. Click on the hat symbol and you will see sources appearing in publications

appear with a circle

3.3. Click on your source

3.4. This will show the publicational on the first column, the authors in the second

column, the journal in which it was published in the third and the date in the

last column

3.5. Fill in Table 11 with the information about your sources

Source Title of publication Date

1

2

Table 11: Publications featuring sources 1 and 2, information retrieved from ESASky

PROCEDURE IN IMAGES:

3.1. 3.2.

3.3. 3.4.
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Phase 4
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Activity 15: Write a scientific publication

Once you have completed your research,  it is now time to explain your method and results

obtained. To do this, write up your findings in the format of a scientific paper, just like a

researcher would do.

Title: It should contain summary information about your research. At the same time, it

should be a title that catches the attention of those who read it.

Team members: Write the names of the team members in this format: Last Name, First

Name

Summary:

Summarizes the objective of this research, the results obtained and how this study

contributes to the scientific community.
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Introduction:

Introduce basic concepts of your study.

Explain the type of object you are

looking for (stars in the process of

formation) and the region you are

investigating (Trumpler 14, inside the

Carina nebula).

Observations:

In this section describe the type of data

you are going to use for your research,

including the sources of these data. The

idea is that anyone reading this

publication will be able to reproduce your

work later.

Analysis of the data:

Explain the results you have obtained and the procedure to reach them.

Relevant graphics which should definitely be included in this section are:

P.S: don’t forget to write captions for the

figures!
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Conclusion:

Explain the conclusions you draw from your results.

Bibliografía:

Make reference to any material you may have used for information such as web pages,

scientific publications, etc.

Title:

Team members:

Summary:
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Introduction: Observations:

Analysis of data:
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Conclusions:

Bibliography:

Congratulations!

● You have completed the Scientific Challenge!

● Tell us your story!

Think about your experience with your team and teacher and complete these Activities.

Activity 16: Congratulations! You have achieved your goal

● In teams: complete this quiz to check your understanding of this Scientific

Challenge

● With your teacher: give us feedback
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Activity 17: Present your results

Students should create a final product (an A0 poster in pdf, using powerpoint for example)

and explaining what they have learned in the different phases of the Scientific Challenge.

This poster is the ticket to participate in the International CESAR Adventures

contest.
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Links

LINKS FOR PHASE 0:

https://kids.britannica.com/kids/article/Katherine-Johnson/628677

https://www.nytimes.com/2016/12/27/science/vera-rubin-astronomist-who-made-the-cas
e-for-dark-matter-dies-at-88.html

https://www.esa.int/kids/en/learn/Life_in_Space/Astronauts/Samantha_Cristoforetti

https://es.wikipedia.org/wiki/Marie_Curie

https://es.wikipedia.org/wiki/Steve_Wozniak

https://www.famousbirthdays.com/people/matt-taylor-scientist.html

https://www.esa.int/Science_Exploration/Human_and_Robotic_Exploration/Astronauts/Pe
dro_Duque
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https://es.wikipedia.org/wiki/Albert_Einstein

LINKS FOR PHASE 1:

VIDEOS:

https://cesar.esa.int/index.php?Section=Multimedia&Id=96

https://youtu.be/hyGsrCIIV6o

https://youtu.be/2-TtcfmbrkI

https://youtu.be/Aehqb-vDV_w

https://www.esa.int/ESA_Multimedia/Videos/2010/03/XMM_10_years/(lang)

https://scied.ucar.edu/video/sun-magnetic-field-rotate-tangle-movie

https://sci.esa.int/web/herschel/-/59541-herschel-unlocking-the-secrets-of-star-for
mation

https://youtu.be/qixEDMUk0QM

APP/GAME/QUIZ:

https://phet.colorado.edu/sims/html/blackbody-spectrum/latest/blackbody-spectru
m_en.html

WEBS:

http://auger.org/education/Auger_Education/celestialcoordinates.html

http://abyss.uoregon.edu/~js/ast123/lectures/lec13.html
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http://blog.cupix.com/

https://www.birmingham.ac.uk/Documents/college-eps/physics/outreach-documen
ts/educators-and-general-public-documents/hrdiagram-workshop.pdf

https://lonewolfonline.net

https://www.exploratorium.edu/

www.daviddarling.info

https://cienciaes.com

http://www.elcielodecanarias.com/portfolio-daniel-lopez-eng/

http://www.mstworkbooks.co.za/natural-sciences/gr9/gr9-eb-05.html

https://cesar.esa.int/index.php?Section=SSE_The_Color_of_the_Stars&ChangeLang
=en

https://www.sciencelearn.org.nz/resources/750-heat-energy

https://sci.esa.int/web/herschel/-/59534-herschel-s-view-of-orion-b

https://kids.frontiersin.org/

https://scienceblogs.com/startswithabang/2013/05/10/where-does-an-earthquakes
-energy-come-from

https://www.sciencemag.org/news/2014/02/close-look-young-star-finds-chemical-
surprise

https://exoplanet.mtk.nao.ac.jp/eng/seeds

https://www.researchgate.net/figure/The-different-phases-of-star-formation_fig8_31
4283237

https://astronomy.stackexchange.com/questions/2526/how-can-pre-main-sequenc
e-stars-radiate-more-energy-than-main-sequence-stars
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https://ay201b.wordpress.com/2013/05/03/article-interpreting-spectral-energy-distri
butions-from-young-stellar-objects/

https://webs.ucm.es/info/Astrof/users/jaz/TRABAJOS/UGARTE/3.htm
http://www.esa.int/ESA_Multimedia/Images/2019/02/ESA_s_fleet_of_cosmic_obser
vers

LINKS FOR PHASE 2:

VIDEOS:

https://cesar.esa.int/index.php?Section=Multimedia&Id=126

APP/GAME/QUIZ:

https://cesar.esa.int/form.php?Id=22&k=ZTKAN7bIkB&ChangeLang=en

LINKS FOR PHASE 3:

WEBS:

https://www.futurity.org/carina-nebula-stars-871632/

https://arxiv.org/pdf/0705.3053.pdf

https://academic.oup.com/mnras/article/367/2/513/1011675

https://academic.oup.com/mnras/article/456/3/2406/1089538

https://hubblesite.org/image/3693/news

https://sky.esa.int/

http://star.bris.ac.uk/~mb/topcat

http://simbad.u-strasbg.fr/simbad/sim-fcoo
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LINKS FOR PHASE 4:

APP/GAME/QUIZ:

https://cesar.esa.int/form.php?Id=22&k=ZTKAN7bIkB&ChangeLang=en
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